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Quick Start Guide and Handbook 

The goal of the SOLIDWORKS® Technical Support team is to provide high-quality technical responses to resellers’ 

inquiries in a timely and consistent manner.  The SOLIDWORKS Siebel Call Center (Siebel CC) is an internal application 

used to track and modify requests for service and to better facilitate customer interaction.  For SOLIDWORKS Technical 

Support Engineers (TSEs), this is where you will process and document all Service Requests (SRs). 

In this Quick Start Guide, you will go through an example workflow of handling a very simple and straightforward Service 

Request (SR).  This will serve as an introduction to the SOLIDWORKS Siebel Call Center, its User Interface (UI), and how 

to process a very simple case. 

Note: As a SOLIDWORKS TSE, you will handle a variety of cases with different levels of technical and communication 

complexity.  Later chapters of this Siebel CC guide will cover other considerations you will need to be aware of when 

solving these more complex cases.  Most of the essential information, technical tips, resources and procedures you will 

need to effectively use Siebel are here in this guide.  So this guide is also a Handbook for you to use in resolving our 

customers requests. 

In this guide, the Siebel Call Center UI top tabs (Screen Tabs) are referred to simply as “tabs”, and the tabs within the 

SRs (View Tabs) are referred to as “subtabs”. 
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1.1. Siebel Login 

The SOLIDWORKS Siebel Call Center is for internal access by Dassault Systemes (DS) employees only.  To access 

Siebel, you must be connected to the internal DS network, either by connecting to the internal DS network in-office, or 

using the VPN if working remotely.  Access Siebel through the following URL:  https://swsiebel.solidworks.com/ 

 

https://swsiebel.solidworks.com/
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Siebel supports the following web browsers: Mozilla Firefox®, Google® Chrome, and Microsoft® Internet Explorer 

11.  If you have any trouble loading Siebel, connect to the DS People Support website to create a ticket.  [TIP: When 

bookmarking Siebel for future access, you should bookmark the URL “https://swsiebel.solidworks.com” without any 

additional text.  When you click on the bookmark, your network will translate it into a fully formed URL with the correct 

parameters for you.] 

All Siebel users must have valid login credentials.  On this login screen, you will enter the Siebel User ID and password 

that were provided to you.  Your assigned User ID is different from your DS Trigram.  New user accounts can be 

requested through the DS People Support website, and they will require managerial approval.  If you forget your 

password, you can use the “Forgot Password?” button to request a password reset. 

 

1.2. Siebel Home Tab Page 

Once you log into Siebel, you will automatically be brought by default to the Home Tab, which is a page that displays 

information specific to your account.  This page is also a connection point for all Siebel functions available to you. 
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When you click on “Service Requests” on this page, you will navigate to your Service tab page, with your current SR list, 

as shown in this example: 

 

This is where you will do much of your work.  Above is an image of a current Siebel Service tabpage. It shows a list of a 

TSE’s recent Service Requests.  An active SR has a status that is Open or Pending, not Closed or Cancelled.  In this 
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section, we will walk you through some basic activities for a TSE to quickly familiarize you with the Siebel CC 

environment.  Later chapters of this guide will have more information about navigating through the Siebel user interface, 

including how to customize queries and record displays. 

In this Quick Start Guide, we will demonstrate the process of answering SR 1-20572422182, which is a quick question 

about SOLIDWORKS Simulation installations: 

 

Note that the SR number is colored in blue, indicating it is a clickable hyperlink.  Clicking that link instructs Siebel to 

present that SR record to you. 

 

1.3. Service Request Tab and Basic Information 

After clicking the SR link, you are brought to the Service tab.  Within the Service tab, you can find records of Service 

Requests.  The SR number is unique and generated automatically.  Each SR record contains information related to it.  

Much of this information is displayed in the Service tab, but some of the data is located in other tabs.  In this Quick Start 

Guide, we will be focusing on the More Info and Activities tabs. 

Depending on your configuration, navigating to a Service Request in the way that you did will bring you either to the More 

Info subtab, or to the Activities subtab, which is where your communications with the SR contact take place.  We first want 

to look at the information associated with the SR which is located in the “More Info” subtab.  You can navigate there either 

by clicking on the “More Info” subtab (red arrow) or by clicking on the SR number link (blue arrow), as shown below. 
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1.3.1. Service: More Info Tab 

The “More Info” tab contains information about the SR, the end user (the customer, highlighted in the blue box below), the 

SR contact (the VAR, highlighted in the red box below), the status of the SR, and much more. 

The first service request assigned to you as a new hire will be manually assigned to you by your mentor or manager, and 

it should be relatively straightforward and simple in nature, like this example SR.  The rest of this Siebel Guide will cover 

more intermediate and advanced Siebel topics, and explore other considerations you need to know when processing a 

wider variety of cases.  Here, we will assume this Service Request was filed by a VAR through the VAR portal (VRC), 

which will be typical for the majority of SRs you will work on. 
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There are many data fields, each with important purposes.  Here are the fields that you would typically look at first when 

receiving a new SR: 

 Severity: The customer impact of the issue, which dictates many things including the Service Level Agreement 

(SLA) response times that you should aim to meet. 

 Agent Opened: This shows when the SR was created.  You need to know how long the VAR has been waiting for 

a response, so you can communicate with them appropriately. 

 Source: This tells how or where the SR was created.  For SRs created in the VAR portal, the source will be 

“Portal,” and you will primarily communicate through Siebel.  In later chapters, you will learn how to identify and 

handle cases received through other sources, like email. 

 The SR Contact Information: Boxed in red, this identifies the contact of the SR, the person you will primarily be 

communicating with.  The SR Contact is the VAR in most cases. 
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 The End Customer Information: Boxed in blue, this identifies the end user.  The end user is usually a customer, 

but can sometimes also be a partner or the reseller. 

 Owner: The owner is the TSE who is assigned to this SR.  For cases assigned to you, the owner will be your 

Siebel user ID. 

 Summary: A brief description of the issue or question. 

 Problem Description: More information about the issue or question. 

 

1.3.2. Initial Review of the SR Information 

When first reviewing an SR, you are trying to understand the end user’s question or problem, as well as the current state 

of the SR. From the fields mentioned above, you will understand: 

 Who you are working with 

 How to communicate with them 

 The SLA response times you are aiming to meet 

 What the problem is 

In this example case, we can immediately understand: 

 The SR contact we will be communicating with is Chung Ping Lu, from the VAR SolidXperts Inc. 

 Since the source is “Portal” we will be communicating with them through Siebel.  

 From the Agent Opened and Severity fields, we will know how urgent the case is and how quickly we must 

respond. 

 The nature of the question. 

In other cases, you may need to also look at customer files or models, which would be in the Attachments subtab.  

However, in this example, the question is straightforward and easily-understood.  From this point, you can investigate the 

issue or question and craft a response that addresses it. 
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Future chapters will cover cases where you would need to first request more information or user files in order to 

understand the request.  

 

1.4. Working on the SR 

Once you have reviewed the information in the SR, you need to make sure you understand what the user needs. In this 

case, it is a straightforward question: 

“Can I run SOLIDWORKS Simulation 2019 on Windows 8.1?” 

 

1.4.1. Find the Answer 

Fortunately, this answer can be found directly on the SOLIDWORKS Website, as shown in the screen below. 
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The answer to this question is clearly that no, SOLIDWORKS 2019 does not support the Windows 8.1 operating system.  

So you can now begin typing up an appropriate response. 
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1.4.2. Write a Response 

When authoring a written response, you always want to be professional, concise, technically accurate, and consistent.  Do 

not use slang, jargon, foreign phrases or metaphors.  Keep the use of acronyms to a minimum and define them when you 

do use them.  Make sure your punctuation and spelling are correct. 

[TIP: A recommended practice is to create, edit, and save your responses using external software such as OneNote, 

Word, Excel, Notepad, etc.  This will let you have a saved copy of your responses, which can help in cases where your 

Siebel session times out and a response is not properly saved.  It also lets you thoroughly spell and grammar check your 

responses.] 

For this SR, the question has a very definite answer, so any back and forth communication is not necessary.  A good 

response to the inquiry could be: 

“Hi Chung Ping, 

Thank you for contacting SOLIDWORKS Technical Support. 

SOLIDWORKS 2019 does not support Windows 8.1 operating systems.  For more information, you can refer to the SOLIDWORKS 

System Requirements webpage: 

https://www.solidworks.com/sw/support/SystemRequirements.html 

As noted on the webpage, SOLIDWORKS 2019 supports Windows 10 (64-bit) and Windows 7 SP1 (64-bit) only.  

If you need to install SOLIDWORKS on a Windows 8.1 machine, SOLIDWORKS 2017 and 2018 both support Windows 8.1 (64-bit).  

As this should address your inquiry, I will close out this Service Request at the end of the day on Wednesday unless you have any 

further questions.  Please also feel free to re-open this SR as needed. Thank you, and I hope that you have a nice day.  

Best Regards, 

Jon Doe 

SOLIDWORKS Technical Support Engineer 

https://www.solidworks.com/sw/support/SystemRequirements.html
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In this response, we are have done the following: 

 Addressed the VAR 

 Thanked them for contacting SOLIDWORKS Technical Support 

 Answered their question in a very direct way 

 Provided them some additional information that would potentially be useful to them 

 Directed them to the official documentation that provides this information 

 Informed the VAR that we will leave the SR open for questions until the end of the day on Wednesday.  

 Reminded the VAR that even if the SR gets closed, they are able to re-open the SR as needed.  

For more complex cases where you need more information, require more time to investigate an issue, or expect back and 

forth communications, you would craft an appropriate response. 

 

1.4.3. Communicate the Answer to the VAR 

Now that you have a written response prepared, you will need to communicate it to the VAR.  For SRs received from 

VARs through the portal, your primary method of communicating information back to the VAR will be done in the Activities 

subtab using Web Update. 

You will perform or record communications and other written notes on the Activities subtab.  Activities that you create are 

saved to the specific SR record that you are working on.  There are many types of Activities that can be recorded in this 

subtab (to be described later in this guide), but the one we focus on here is the Web Update. 

A Web Update is an activity that allows you to communicate written text to the VAR.  The Web Update activity is visible to 

the VAR within the SR record in their portal.  The VAR will also automatically receive an email that contains the text 

comment of the Web Update. 

First, to create a new activity, go to the Activities subtab and click the “+” button as shown below. 
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When this button is clicked, a new activity will be created and shown in the Activities list.  By default, this activity has the 

type Web Update.  You can either type your response directly into the “Comments” box of the activity, or copy-paste the 

text into it.  The Web Update field has a size limit and will truncate large entries.  [TIP: A best practice is to limit your 

text size to 1,950 characters (remember the space character ‘ ‘ counts as a character)]. 
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When creating activities only to share information with the VAR, be sure that the “Show Customer” checkbox is cleared.  

This option controls whether or not customers will also be able to see the update you post, and is disabled by default.  

Typically, TSEs only communicate directly with the VAR, and the VARs use the information to work with and communicate 

with their customer. 

[TIP: If pasting text into the comments field, you will want to double-check the formatting and spacing to make sure it is 

readable.  Siebel edit controls do not support text enhancements like bold or italic, etc.]  

Please remember that there is a character limit for the comments of an activity.  For lengthy text updates we recommend 

you either split the text into two (or more) separate updates, or attach it as a text file (which will be described in later 

chapters). 

Once you have typed or pasted the Web Update’s text into its Comments field, you are ready to have it saved and 

emailed to the VAR.  You can save the record by pressing ‘CTRL+S’, by clicking on the Activities menu (the gear icon in 

the Activities subtab) and choosing “Save Record,” or clicking on a different tab.  Performing any of these three actions 

will save the Web Update activity so that it is visible in the VAR’s SR record, and it will also automatically send the VAR 

an email that references the Service Request and includes the new Web Update’s Comments. 
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1.4.4. Updating the SR Status 

Now that you have sent an answer to the reseller, you must go back to the More Info tab to update the status of the SR. 
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In the More Info tab, the Status and Substatus fields are used to keep track of and communicate the current state of an 

SR.  The most common Status values used by TSEs are: 

 Open: Issues not yet investigated by TSEs should have the status “Open”  

 Pending: Once the issue has been investigated by the TSE and customer feedback is expected, you should 

change the status to “Pending” 

 Updated: If the SR receives an update from the SR Contact while in a “Pending” state, the status is automatically 

changed to “Updated” to indicate to the TSE that there is a new update to the case. 

 Closed: Once a case is fully resolved, its status should be set to “Closed” 

The Substatus is used to more clearly define the current status of the SR.  Common Substatuses are: 

 Unassigned: Before an SR is assigned to a TSE (no Owner is defined), its Substatus should remain as 

“Unassigned” 

 Assigned: Once a TSE is assigned as the owner of an SR, the Status should be changed to “Assigned” 

 In Process: You can use this Status to indicate that the SR is being actively investigated.  Some TSEs use the “In 

Process” Substatus in different ways. 

 Waiting on Customer: If customer or reseller information is required before continuing work on the SR, you can 

use the “Waiting on Customer” Status. 

 Resolved: When an answer has been provided and the case is resolved, you can use the Status “Resolved.” 

Note that when you set an SR to the “Waiting on Customer” or “Resolved” Substatuses, Siebel will automatically populate 

the “Auto Close Date” field of the SR to be seven days from the current day.  What this means is that unless the 

Status/Substatus of the SR is changed within those seven days, the SR will be closed automatically.  The Auto Close 

functionality will be explored in more detail later in this guide. 

For the example SR, as no changes were made since the SR was assigned, its Status is still Open / Assigned.  In this 

case, since we are confident that we have answered the VAR’s question, we should change its Status to Pending / 

Resolved (or Pending / Waiting on Customer) while waiting to see if there are any further questions.  To do so, choose the 

drop down menu for Status and choose Pending. 
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After that, you can similarly set the Substatus to Resolved. 

 

Finally, make sure you save the record by pressing ‘CTRL+S’ or choosing “Save Record” in the Service Request menu.  
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Since we communicated that we would leave this SR open until the end of day Wednesday in case there are further 

questions, you would need to keep track of the SR until then to make sure you catch any updates from the VAR.  If the 

VAR did post their own Web Update, you would receive an automatic email and see it in the SR’s Activities tab. 

 

1.4.5. Keeping Track of an SR 

In our example case, the VAR responded to let the TSE know that their question was answered.  When they posted their 

Web Update, the following email was sent to the TSE automatically. 

 

In Siebel, this also automatically updated the SR to the Status Updated / In Process.  From the Service Tab page, you 

would see something like this: 
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In the Activities subtab of the SR in question, the VAR’s Web Update can also be viewed: 

 

 

1.4.6. Closing a Fully Resolved SR 

In this case, since the VAR has already stated that we can close the SR, we can simply do so.  You can also send them 

another Web Update thanking them for their reply and letting them know that you are now closing this SR.  Use your best 

judgement to feel out the situation to determine how to communicate appropriately. 

To close out the SR, you will return to the More Info subtab in order to change the SR Status.  However, before closing 

the SR, it is good practice to set the Incident Type to indicate what type of case it ended up being.  For this example, it 

was a how-to type of question, so you would choose “How To” for the Incident Type. 
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Finally, go to the Status field, change it to “Closed,” and save the record by entering ‘CTRL+S’ at the keyboard.  
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Once the SR is closed, it is also automatically given the Substatus Resolved.  While closed, the majority of the SR fields 

are also locked from further editing and greyed out.  However, you could still add activities to the Activities tab, change the 

Severity, change its Status / Substatus, and perform some other operations.  

Additionally, VARs have the option of reopening a closed SR within 30 days of its being closed. 

This SR is now closed and resolved.  In upcoming sections of this Siebel Quick Start Guide, you will see more complex 

cases and communication scenarios, queries, attachments, and best practices. 
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2. Queries and Searching 

2.1. What is a Query? 

A database is a collection of related but unique data items called records.  These unique records are organized by a 

principle to make operating on them predictable, safe and efficient.  A predictable database means that if you insert a 

record, you can reliably find it later.  A safe database means that access to it is secure and that data can not be lost or 

destroyed.  An efficient database means that operations on it occur in a reasonably fast manner. 

 

The Siebel CC is a database organized to manage and operate on service requests.  This type of database is called a 

Customer Relationship Manager (CRM).  Our customers use the SOLIDWORKS family of products, and the Siebel CC is 

the system used to manage all service requests from them.  Customers and VARS create service requests for help in 

using SOLIDWORKS products.  TSEs handle and resolve these service requests. 

 

Searching is a strategy to find information in a database.  A query is a means to find specific needed data.  In our context, 

a query is a highly structured means to find a specific service request.  As a TSE, you query Siebel to find and access the 

record containing the service request you want to work on and resolve.  The service request record contains several kinds 

of information, including: 

 The specific product and license at issue 

 The description of the problem 

 Information about the customer 

 Information about the VAR representing the customer 

 Ancillary data:  Rx files, scenarios, procedures and outcomes, screen / video capture attachments, etc. 

 Issue status and handling 

 Facilities to communicate with VARs and even customers 

 

The service request record consists of data items in fields and attachments.  You query Siebel to access a service 

request, examine its data and attachments, assess the issues in the service request, and proceed to handle the service 

request.  Along the way, you update the status of the service request.  You may need to request additional information to 
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better understand the issue, and ultimately resolve it.  The Seibel CC captures all of this data and activity in the service 

request record. 

 

As a TSE, you have a powerful and flexible tool for querying and searching SRs using the SOLIDWORKS® Siebel Call 

Center.  When you login to Siebel, it runs a default query.  The TSE sees a search list of open and assigned SRs, Siebel 

highlights the first record on the list and populates its contents in the Service tab record for that item.  The TSE can begin 

by working on that highlighted SR, or conduct a query to find a different SR to address. 

 

The following query functionalities are basic and built-in to Siebel: 

 The TSE can query directly any list of SRs 

 Queries return a populated list of SRs, filtered by search parameters 

 Clicking on any tab in the Siebel UI runs a query to present that tab’s data 

 Most fields on all tabs are searchable 

 The TSE can search one field or multiple fields simultaneously, each with its own parameter 

 Any query result can be further refined and requeried to select a more precise SR 

 The TSE can define custom queries to work faster and better 

 The TSE can alter Siebel default queries for better performance 

 

2.2. Queries Within A Record 

The TSE can conduct a query from any record displayed in Siebel, at any time.  The record can be empty or populated.  

Here are some UI basics.  The Siebel CC record display is also a field editor.  The TSE can edit any field that is not 

grayed-out.  The TSE can type in a new value in an empty field, or replace a current value by typing, or cutting and 

pasting a value, or selecting an element from the field’s drop down list, if it has one.  The Siebel record display always has 

a ribbon strip across the top with some basic editing controls, as shown here: 
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The TSE can mouse-over the ribbon controls to get a pop-up description of each control’s function.  Select the magnifying 

glass control in the ribbon for queries: 

 
 

When you click on the Query control, Siebel replaces the current record with an empty record, as shown here.   

 

 
 

The TSE can enter values in one or more fields in the record.  Each entered value is a search parameter.  Fields marked 

with a red asterisk (*) are only mandatory for creating a new record ; for a new query they are optional paramenters.  

Your entered parameters become a filter when you launch the query.  Search engines use filters to reduce the number of 

matches in the resulting list (or record set).  Only items that match the filters are returned in the list. 
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Note that the ribbon strip now has a different set of controls.  The TSE uses the Go ’­>’ control to launch the query.  In the 

example shown below, the TSE is going to launch a query by searching for a specific SR entered in the SR # field: 

 
 

When you run a query, Siebel will use your information as field parameters and return a list of SRs that match ALL of your 

parameters.  This list could be empty, or it could have one or more entries.  The first item on the list will always be 

highlighted and its data will displayed on the current record below the list, as shown here: 
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We mentioned that most fields are searchable.  However, some fields lend themselves to frequent searches.  Siebel has a 

flexible syntax for doing targeted searches.  This Siebel syntax is unique, but it is not open-ended like Google®.  Unlike 

Google, entering phrases or search terms will probably not find SRs.  [TIP:  the optimal search strategy is to use 

keywords to do targeted searches.  DO NOT USE the Siebel Keyword field to save or search for keywords.]   

 

Enter one or more keywords to do general searches.  There is only one field available for generalized searching: 

 Summary (brief description of the problem, usually with keywords) 

 

You can enter your keywords in the Summary field and use specific fields with parameters to narrow your search.  [TIP:  

enter your keywords with wildcard characters and the OR operator.  Example:  *install* OR *update*.  Search operators 

are covered later in this guide.] 

 

The Problem Description field expands on the summary.  However, it is NOT an eligible field for a query. 

 Problem Description (detailed, with steps to replicate, scenario descriptions, observed outcomes, etc., usually 

with keywords) 

 

TSEs can also use One Search, which will canvas all fields, including the Problem Description, briefly described later.  

One Search is an advanced topic not within the scope of this guide. 

 

Here are some typical fields to use for searches, where you need to find specific data items: 

 SR # (unique Service Request Identifier) 

 Serial # (SOLIDWORKS licensing data) 

 SR Account (VAR) 

 End Account (SOLIDWORKS customer) 

 End Site (customer location) 

 Agent Opened (date the SR was reported) 

 Status 

 Substatus 

 Owner (assigned TSE) 



32 
 

 

You can search for one, a few, or even all of these fields simultaneously using specific values.  You can also do searching 

with expressions and formulas.  The grammar and syntax of search expressions is an advanced topic we will cover later 

in this guide.  However, here are some handy and common techniques for doing searches.  They are: 

 Use ‘=’ to find an exact match.  (End Account: = “Charles 555 S”) 

 Use ‘OR’, ‘AND’ and ‘NOT’ to do multi-value searches on a field.  (Summary:  “Installation OR Update”) 

 Use Today() with numerics for date expressions on a field.  (Agent Opened:  “Today() – 5”) 

 Use < or > for date range searches on a field.  (Agent Opened:  > “Today() – 21”) 

 Use LIKE with wildcard characters:  ‘*’ matches one or more characters and ‘?’ matches a single character in a 

partial search string.  (Summary:  LIKE *install* OR LIKE *update*) 

 

You can find a complete reference to all Siebel field search options and syntax in the appendix at the end of this guide. 

 

You can click the Cancel control ‘X’ to remove the edits and populate the record with the last SR previously viewed. 

 

If you enter an SR number and query on it by clicking the magnifying glass icon, Siebel will find the record and populate 

the screen with its data, as shown here: 
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The ribbon strip now has the standard set of editing and searching controls again.  If you click on the New control ‘+’, the 

current SR is retained, but you now have updatable fields for editing.  These fields are available as additional query 

parameters to narrow your search.  For example, you could change the Severity field, or alter the Substatus field, as 

shown here: 

 

 
 

Typically, as a TSE you will select an Open Assigned SR, and immediately change its status from Open to Pending, 

indicating that you are now working on it.  You might need to change the Severity by upgrading or downgrading it. 

Remember if you change the Severity to High or Critical you must also add a valid Security Reason to the SR before you 

can save it. 
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There are several methods to save any edited record after doing a query for an SR.  You can use a handy shortcut 

command to do a save by entering ‘CTRL+S’ at the keyboard.  You can also click the gear icon (Menu) on the ribbon 

control strip.  This action launches a pop-up menu with a scrollable list of common commands and their associated 

shortcuts, as shown here:   

 
 

Simply click on Save Record to do the save.  You will be prompted to enter values for any required fields that are empty.  

Note the Save Query As command on the list.  We will demonstrate saving your own custom query in the next section. 
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2.3. Saving and Deleting Your Own Custom Queries 

As a TSE, you will find that you often perform many queries in the same way.  These repetitive queries are a search 

pattern, and they are candidates for you to capture as custom queries.  For example, you might want to know what kinds 

of issues for a specific product and VAR have been reported in the past year.  You might query for this on a regular basis.  

Instead of manually constructing this query every week, you can create a custom query that you can save by name, and 

then invoke when needed. 

 

Construct the query for your specific need.  To save the query, you can either enter ‘ALT+S’ at the keyboard, or click on 

the Query > Save Query As… top menu, or click on the menu gear control to bring up the drop down command list, and 

then click on ‘Save Query As [ALT+S]’ as shown here: 

 
 

Query > Save Query As… Menu Command 

 
 

Save Query As Drop Down Command 
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After you enter the Save Query As command, Siebel brings up a dialog box to allow you to save the custom query by 

name, as shown below.  This ordered list of queries includes both built-in standard queries and any custom queries you 

may have created.  Type in the desired name in the Query Name field.  Your name for the custom query must be unique.  

This custom query will be private to your login.  It is not shareable.  [TIP:  Use a special character to preface your query 

name to place it near the top of the alphabetized list of queries.] 

 

 
 

To run a saved query, select it from the top menu bar’s queries drop down list, as shown below: 
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Your custom queries cannot be viewed or edited, but you can create variations of them with different names.  However, 

you can also use Refine Query to change a custom query, as described in the next section. 

 

To delete a custom query, use the top application menu command: 

 
This brings up a pop-up dialog box to allow you to select the custom query to delete.   
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Click ‘OK’ and your custom query is deleted.  TSEs cannot delete standard queries.  You can create your own variation of 

a standard query, provided you give it a unique custom name. 

 

 

2.4. Using Refine Query 

You can refine the parameters of any query, including a predefined query or a query you saved earlier.  [TIP: If you refine 

the parameters of a predefined (Siebel built-in) query, you can only save your changes by saving the query with a different 

name.  This newly named query will only be accessible to you.] 

 

You use the Refine Query command to filter a conducted search with additional parameters.  There are several ways to 

refine a query.  They are: 

 The keyboard shortcut for Refine Query is ‘ALT+R’ 

 Click the top application menu Query > Refine Query [Alt+R] 

 Left clicking the Gear icon presents a clickable list of common keyboard shortcut commands, including Refine 

Query (see the image here): 
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Additional fields can have new parameters added for Refine Query.  To refine an existing query, select the query you want 

to refine from the Queries dropdown list.  Note: To repeat the query currently shown in the Queries dropdown list, click the 

menu button, and then click Run Query.  Matching records appear in the application window.  Click the menu button, and 

then click Refine Query.  Your query is then presented in the Siebel record area with other fields cleared, and it is ready 

for you to refine. 

 

Alternatively, you can use the Siebel application level menu to perform this and other related tasks.  This menu is at the 

very top of the Siebel screen, as shown here: 

 

 
 

From the application level menu, choose Query > Refine Query.  The Query submenu is shown below.  Refine your query 

criteria by changing or completing the fields.  Click the Go control, or enter the keyboard command ‘ALT+ENTER’.  

Service requests that match your criteria appear. 
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To save the refined query with the same name, from the application level menu choose Query > Save.  To save the 

refined query with a different name, from the application level menu choose Query > Save Query As, enter a unique name 

for the query, and then click OK.  Refine Query allows you to add another filter to an existing query, and to easily build 

your own library of related queries. 

 

2.5. Using Record Count 

Quite often, you will run queries that return a large list of SRs.  For example, use the Queries drop down list to select the 

Siebel standard query Open SR’s, as shown here: 
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This returns a list of all Open SRs across all organizations.  This list is scrollable.  However, you have no sense of the 

scale of this list.  To get a count of just how many SRs are currently Open, click the Gear control to bring up the pop-up 

menu and select Record Count, as shown here: 

 
Record Count Drop Down Command 

 
 
 
 

 

 
 
 
 
 
 
 
 

Typical Siebel Open SRs Result 

 

You could also enter ‘CTRL+SHIFT+3’ at the keyboard.  In this example, Siebel reported 5,105 Open SR records.  This 

may seem like a large number.  However, if you ran the Siebel New SRs query, you would experience a very noticeable 

delay as Siebel tallied ALL new SRs with any status.  You would get a wait animated icon (a revolving red oval) in front of 

the Siebel screen: 
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When finished,  the tally might be reported as:   There are  1271854  records in your query for  Service Requests “ 

Whether the list is over 5000 or over a million, it is not a manageable list. 

 

One list and count the TSE needs daily is the tally of all Open status and Assigned substatus SRs.  To make this a readily 

available list, you need to create a custom query with the status field set to Open and substatus field set to Assigned, and 

of course enter your correct Siebel user name in the Owner field.  Save this Query with a recognizable name like ‘My 

Open SRs’.  When you start work, run this saved Query and when you get the list, run the Record Count.  With this 

information, you can begin to assess and prioritize your workload. 

 

A more useful query would be to specify your Group, as shown here: 

 

 
This query will return not just the list of the TSE’s SRs, but also the list of all Open Assigned SRs in the group, to give a 

broader context.  An example of this query result is shown below: 
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Here the count is 8 records.  Notice that this list is for Simulation Support worldwide.  This query could be further refined 

by adding a filter for Site, etc.  You will also need to query for Severity, to find recent high impact SRs that need 

addressing.  Here is a sample query for PDM Support for Critical or High SRs that had an Open status in the last five days 

or sooner: 
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This sample query returned 12 SRs, and the list is shown below.  Note that some of these SRs are still unassigned (they 

have no Owner value).  As a TSE, you would want to examine these SRs first. 

 

 
 

2.6. Querying the SR List itself 

When you launch Siebel, you may have it setup to land on the Service tab, or you may routinely click the Service Tab.  

When clicked, this tab runs a default query of all SRs across all organizations.  The record count for that query result is 

shown below. 
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As a TSE you are mainly concerned with those SRs in your support area.  However, Siebel allows you to query any list of 

SRs at any time. This facility is built into the SR display area.  Notice the upper right area of the SR List display area.  

There is a cluster of quick query controls available.  See below: 
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The upper control showing ‘All Service Request across Organizations’ is actually the default setting of a drop down list.  If 

you select the other two settings, a different sublist is presented.  The most useful is the ‘My Service Requests’ selection, 

which presents all Siebel SRs that have you as the Owner.  This is a much more manageable list.  This list will have any 

SR record with any Severity, any Status or any Substatus that has your Siebel account name in the Owner field.  From 

this list, you could quickly see all SRs you are currently working on. 

 

In the left most selector, all available Siebel fields are in a scrollable dropdown list.  Pick the  Status’ field from the 

dropdown: 

 
 

In the right side edit control, enter ‘Pending’.  Click the Go control (->).  This list now shows all current Pending SRs (see 

below).  You could click on any subtab (view tab) to sort by that field.  This list query facility is not intended for drill down 

queries.  However, it is a quick way to get a fast snapshot of filtered SRs. 
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2.7. Exporting Query Results 

The Siebel CC allows users to export data.  You can do this by selecting the data to extract and the formatting of the 

extract.  Once extracted, you can use a tool like MS Excel® to analyze the data, compute metrics and do other related 

tasks.  [TIP:  your time zone setting will affect the date time stamps on your exported data.  You may need to change your 

time zone before you run your query and export the data.] 
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The first step is to select the data for an extract.  In our context, the TSE runs a query to generate an SR list.  For 

example, you might want to extract and analyze all of the SRs you handled last year.  You would either construct such a 

query on the fly, or run an existing customized query.  When the results from your query are listed as SR records, the next 

step would be to left click on the Gear control and select Export at the bottom of the scrollable dropdown list: 

 
 

When you click Export, Siebel presents a dialog box for you to characterize the data extract, as shown here: 
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Rows to Export:  You can select All Rows listed, or only the Current Row. 

 

Columns to Export:  You can select Visible Columns listed, or All Columns.  Recall that your view of the data is a 

customized snapshot.  Selecting All Columns will include all of the columns in the data set, not just those you can see. 

 

Output Format:  Siebel will extract the data in a text file, in a variety of formats.  The delimiters separate the field text 

data in definable columns.  The most common file delimiter is Comma Separated Values (CSV).  Each field data item is 

appended with a comma.  The tab character is also used as a field delimiter, but the tab character is a non-printing control 

character.  When you open a text file with tab field delimiters, the tool you use to open the file will interpret the tab 

character in its own defined way.  You can even select your own Delimiter character; however, this feature is for experts 

with specific needs.  You can also extract your data as HTML; this option will create a web page with your data that you 

can view with a browser.  Typically, you will export the data for analyzing with Excel, and Tab or Comma Delimiters will 

work for that.  Since CSV files should only have printable characters, you should select the Comma Separated Text File 

option.  With this option, Siebel will output a ‘csv’ text file. 
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After you choose your options, click the ‘Next’ button.  Siebel will present a common Windows dialog box with the default 

name of the file:  ‘output.csv’, as shown here: 

 

 
 

You can open the file with Excel (or any text editor), or save it to a default location.  The file is a text file in CSV format.  It 

is not yet an Excel file, but Excel knows how to read it.  Below is a sample of a CSV file opened in Excel: 
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If you open it with Excel, you can format it as you need and save it as an Excel file (‘.xlsx’).  Once the CSV file is 

converted to an Excel file, you can do your analysis and generate metrics on it.  This is an advanced topic beyond the 

scope of this Quick Start Guide. 

 

If you did the extract as an HTML file, it will be saved with the default filename ‘output.html’.  It will already be formatted, 

clickable and viewable as a web page, as shown in this sample: 

 
 

Close the Export dialog box when you are done. 

 

2.8. Auto Close Date and More Query Options 

You will find that the Auto Close Date: field is a very useful one.  Sometimes you may resolve an SR and update its 

status and send a note (via the Activities tab) to the VAR or even the customer.  You have indicated in your 

communication that the issue is resolved but you will not set the Status field to Closed until you hear back from the VAR 

or customer.  In this scenario, you would set the Auto Close Date: field to five days in the future, as shown here: 
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Another option for you is the date-time picker associated with the field.  Click on it’s control and then point and click to set 

the date: 

 
 

Siebel will schedule the SR status to change to Closed based on the date value you entered.  When that date is hit, Siebel 

will change the status and automatically send an email notice to the VAR contact defined in the SR Email Address field.  

This is a handy way for you not to have to remember all the SRs that you have waiting on the VAR or customer to 

acknowledge. 

 

When you set an SR to the “Waiting on Customer” or “Resolved” substatuses, Siebel will automatically populate the “Auto 

Close Date” of the SR to be seven days from the current day.  What this means is that unless the status / substatus of the 

SR is changed within those seven days, the Siebel CC will close the SR automatically.  This is described in more detail in 

Section 4.3 on the SR Workflow. 
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As a TSE, you can also use the Siebel query features to handle a variety of situations.  Sometimes SRs can be 

miscategorized because of simple spelling mistakes, miscommunication, or even lack of understanding on the part of the 

VAR or the customer.  If you come across an SR that seems miscategorized, you can use queries to try to find an answer. 

 

For example, an SR may refer to a legacy product, with names that are no longer current.  If the Group field is set to 

Simulation, that affects the display in the Area field.  There are legacy names in that dropdown list that you might see in 

an SR, or you might need to find in an SR, such as COSMOSEMS or COSMOSM, as shown here: 

 
 

You can do a broad query using the LIKE operator, which will search for any combination that matches without regard to 

upper or lower case, etc., for example Group: (LIKE “sim”) and Area: (LIKE “cos”). 

 

Another common scenario is to query for all non-closed SRs under the Technical Support group that were opened more 

than a week ago.  You need to specify NOT=Closed AND NOT=Cancelled in the Status: field, as shown here: 
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The record count for this query when run was 683 SRs, representing an active work list for the entire Technical Support 

team.  This is a query scenario that ought to be saved in your list of custom queries. 

 

 

2.9. Modifying Default Tab Queries 

Remember whenever you click on a Siebel tab, a default query for that tab is executed.  The most salient example is 

clicking on the Service tab.  Siebel is a very flexible, full featured CRM.  As a Siebel user, you can take advantage of this 

flexibility by customizing default tab queries.  The concept is simple:  you pick a customized query from your queries list 

and assign it to the screen’s tab view in question. 

 

Navigate to the Siebel application-level menu (top menu) and select Tools and then select User Preferences (Tools > 

User Preferences), as shown here: 
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This brings up your User Profile screen.  On the link bar, click Default Queries from the submenu (second level view bar): 

 
You will land on the Screen and Screen View pages that allow you to assign a default query.  The Screen list of Screen 

Names is an ordered list.  First, you need to find the Screen Name you want to modify by clicking on the navigation control 

(highlighted with the red arrow below), until you come to the sublist you need. 
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Pick the Screen Name you want to work with.  In this example, we selected the Service Requests Screen Name.  This will 

present a list of its associated Screen View names.  The Screen View page has the Default Query fields.  Click on the bar 

to the right of your desired View Name, which in this example is My Service Requests, as shown below: 
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This opens an edit control.  Enter a value or click on the select control on the extreme right of the edit control: 

 

This will launch a Pick Query dialog box with a list of your associated defined queries, as shown below: 
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Click your desired query name to highlight it, and then click OK to set the default query: 

 
When you click the menu control and then click Save Record, or enter ‘CRTL+S’ at the keyboard, your assignment of the 

default query to the Screen Name will be complete.  When you revisit the Screen View page, your Default Query assigned 

name will be shown. 
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3.  Navigation:  UI Elements and Traversals 

3.1. Navigation Elements 

In the context of an enterprise CRM software application like Siebel, navigation is the means for the user, you as a TSE, 

to interact with the software to handle SRs, find and update records, communicate with VARs and customers, and resolve 

issues.  The medium for this interaction is the User Interface (UI).  When you work with Siebel to access records and 

attachments, to communicate, and to update records, you are using the UI to traverse the spectrum of its capabilities.  

These traversals comprise the User Experience (UX).  The UI is a software layer with the means for users to interact, 

and the UX is the process of that interaction. 

Siebel has a full palette of UI controls and mechanisms for you to find SRs, edit and update the records and attachments, 

participate in the application workflow, and to come to a resolution.  Consider the main Siebel starting screen: 
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It has a Graphical User Interface (GUI) accessible with a keyboard and mouse.  It is packed with many different types of 

controls to give you the means to do your work.  Consider the same GUI image with red arrows highlighting the different 

types of user controls: 

 

In the top left corner of the banner is a set of menus, which are only visible when the Application Menu control is clicked.  

On the banner’s right is an advanced find edit control with a selector control.  Below those elements is a set of Application 

Toolbar icon controls.  Below that is a row of Screen Tabs.  In the main view are circles with hyperlinks to navigate to 
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important functions.  They will have counts of current items assigned to you (for example, Service Requests).  Clicking on 

any of these UI elements will start important functionalities.  We will examine all of these user controls here in the guide. 

The Siebel CC UI has additional user controls.  Recall from the first section that if you click on an SR in a list, you will 

open the Siebel record for the SR.  If you then click on the Activities Screen Tab, it will open the Activity Page view, which 

has another lower row of View Tabs, as shown here: 
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There are several selectable views that have an additional row of clickable View Tabs, each with expanded functionality. 

When you examine any list of SRs in Siebel, you are actually only viewing a subset of the list.  The UI has controls that 

allow you to move forward and backward though this list.  These controls are in a central area just below your view of the 

list.  In the example below, the Service tab view has a list of SRs, and the controls are placed just above the lower row of 

View Tabs, as highlighted with the red rectangle: 

 

Clicking on these intuitive controls allows you to view predecessor or successor members of the list, as explained below: 
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When you view or edit an SR record in Siebel, there are edit controls on-screen to assist you.  We saw some of these edit 

controls in the first section.  They are contained in the Siebel List and Form Toolbar, for example: 

 

The actual controls or buttons displayed will vary depending on the tab view and record you are editing.  Note the numeric 

list count with left < (previous) and right > (next) controls.  Here is the Siebel toolbar taxonomy: 
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Finally, we noted the top level (banner) Siebel Application Menu.  The last menu item in that row is ‘Help’.  Siebel has its 

own help system which you may find useful.  Click on it to select and navigate to the help section you need to explore, as 

shown here: 

 

 

3.2. Siebel CC Tab Survey With Some Common Tab Scenarios 

This section has a list of Siebel Screen Tabs and information about their relevance to you as a TSE.  The most often used 

View Tabs are also listed.  We then have three typical tab use scenarios of particular interest to TSEs. 
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3.2.1. Tab Survey 

When you launch Siebel you come to the Home tab and page.  It is on the first level row of Screen Tabs, each with major 

user functions.  The tabs shown vary depending on your login and permissions, your screen resolution and mode of 

display, and any customizations (explained later in this guide).  You may only see a partial list of available tabs.  On the 

right end of the First Level View Bar is a clickable control (˅) to show a dropdown list of the other available tabs , as 

shown here: 

 

The following chart shows the main Screen Tabs and their functionality.  As a TSE, you will use some of these tabs more 

than others. 

Screen Tab TSE Use / Notes 

Enhancement Request Survey Not used by TSEs 

Home Default landing page with links to main functionality 

Accounts Detailed information about VARs, useful for contact data, etc. 

Contacts Detailed information about customers, useful for contact data, etc. 

Assets Information about product serial numbers and licensing status 

Service Almost everything about SRs is found or added here;  many TSEs use a default 
query to make this tab their landing page 

Calendar Useful for organizing and scheduling 



66 
 

SPR Owned by R&D and QA; SPRs can be linked to SRs; useful information on product 
defects and work arounds, and sometimes with customer data 

Solutions Read-only data for searching and accessing Knowledge Base Solutions; can be 
linked to SRs and referenced in an SR solution 

Activities Communicate with customers and other stakeholders, also used to add and get 
attachments for SRs 

Solution Administration Used to create, edit and maintain Knowledge Base Solutions, with fine grained 
controls tor determining visibility 

Service Analytics Detailed comparative data on SRs and SR Workflows 

SR Customer Survey Historical data on customer surveys and campaigns 

Solutions Translations Useful for accessing Knowledge Base Solutions translated into another language.  
Creation is always in English.  Knowledge Base articles are translated as needed. 

OneSearch A relatively new Siebel feature for general searches of Knowledge Base solutions 
and SPRs 

 

You may see additional tabs at a lower level when using Siebel.  These secondary tabs are View Tabs.  The presentation 

of View Tabs is determined by the Screen Tab you just clicked and your ensuing actions.  If you click on a current SR in a 

list, you will open that SR in the Service tab page, with the editor active for the SR selected.  Just above the editor is the 

default row of View Tabs for that scenario, as shown here: 

 

The following chart shows the main View Tabs and their functionality.  As a TSE, you will use some of these tabs more 

than others. 
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View Tab TSE Use / Notes 

More Info Heavily used by TSEs, with additional fields with key SR related data 

Activities You will use this tab page when you need to communicate with VARs and 
customers.  A common scenario is described later in this guide. 

Attachments You use this tab page to add or get attachments related to the SR.  These 
attachments include problem setup steps, instructions, images, test, debug and 
runtime data, etc.  A common scenario is described later in this guide. 

Audit Trail Detailed information about SR work flows and history. 

SPRs You will use this page to add an SPR link to the SR, or to see this link if it is already 
there. 

Related SRs Your SR may have related issues covered by other SRs, or you may need to view or 
add such a link. 

Solutions You may want to view a Knowledge Base solution related to your SR, or add a link 
for a new solution. 

VAR Survey If there is a VAR survey associated with an SR, the survey data will be on this page.  
This page will always be read-only to you. 

 

3.2.2. Lookup Customer Contact Information Scenario 

You may be assigned a new SR and when you examine it you find there is missing information in the problem description 

or there is some other issue requiring clarification before you can proceed.  Or you suspect the SR might be even be 

assigned to the wrong group.  But there is no information in the SR about how to contact the end user. 

This is a very typical scenario.  Here is a recent Open SR with a view of the More Info tab.  It has a customer name, but it 

has no customer contact information.  In the example below, the customer name is the End Account field with the red 

rectangle around it.  The red arrow points to the customer contact email address which is ‘grayed-out’ because you can 

not add or edit a value there.  More imporantly, this field is blank, since that data was not entered when the SR was 

created. 
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In this scenario, you need to copy the the End Account name and then click on the Contacts tab.  When you land on the 

Contacts tab page, you select the Account fiield from the drop down control, and then paste the account name in the find 

field, as shown here: 

 

When you click the Go control (→), Siebel will find the account and display all the customer contact information 

associated with the account.  Since the account is Active, the information retrieved will be current, as shown here: 
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With this data, you can email the customer’s contact person, or even place a call.  Note also that the VAR for this account 

is also shown.  After you initiate the contact, you will probably go back to the SR and change its status to Pending, 

indicating that you have started working on the SR but are waiting for further information. 

 

3.2.3. Lookup Customer / VAR Case History Scenario 

There might be occasions where you need to look at the case history of a customer or VAR.  Perhaps a current SR is a 

variant of a repeated issue for the VAR or customer.  It might mean a customer that is not fully trained, or a VAR who 

does not have a complete understanding of a customer’s needs.  Or you might want to see what other steps have been 
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undertaken for a VAR or customer.  You might even want to know how many and what kind of active SRs the VAR has 

submitted. 

To examine this kind of data you need to land on the Accounts tab page.  Click on the Accounts tab.  Select ‘Name’ from 

the Accounts List dropdown selector: 

 

In the adjacent find control, type in the name of the VAR you want to examine.  If you are not sure of the exact name in 

Siebel, use a LIKE search operator, as shown here: 

 

Click the Go control (→) and the VAR’s account Accounts status will be shown.  If you want to know how many records 

are associated with the VAR get the record count.  Here is an example result: 
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From this list you can find a specific site, then find specific SRs and check the additional data in the More Info, Activities, 

Assets, and Attachments View Tabs. 

For example, if you want to check the progress of the SR and see the VAR’s approach, click on the Activities tab.  This is 

where communication with the VAR and the customer occurs, and there is a record of all interations, allowing you to see 

what has transpired.  You can enter a text control to fill out an email message to the VAR, as shown below: 
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Note that the message is checked as ‘Private’ and that ‘Show Customer’ is unchecked.  Marking the message as Private 

makes it an internal note visible only to TSEs and not to VARs.  The Show Customer checkbox enables the customer to 

be able to see the message if it is checked. 

The Activities tab page keeps a list with links to all internal notes and all correspondence.  You can examine the list to 

trace the events for a particular issue and VAR.  This is essential for resolving complex issues.  An example of this list is 

shown here: 
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The Attachments View Tab is a collection of file based elements added by either the VAR or the TSE.  This could be an 

Rx snapshot, set up instructions, run time data, debug information, screen snaps, and even video content.  You click on 

the links to down-load and examine the attachments.  You use the edit controls to upload new content.  Remember that 

this feature is size constrained.  You also have controls to govern who sees each attachment.  For extremely large files, 

use the Dassault file transfer mechanism to share content.  An example of the Attachments Tab page is shown here: 

 

 

3.2.4. View Assets of Customer / Account Scenario 

 

Some customers may have mulitple licenses for the same SOLIDWORKS products, or for several products.  Some of 

these licenses may be active, others not.  You may need to know some of these details when working to resolve an issue.  

Siebel has consolidated this kind of related information on the Siebel Assets tab. 

Click on the Siebel Assets tab to navigate to the Assets tab page.   
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When you land on this page, it lists ALL ASSETS for ALL customers world-wide.  In this display, we see over 5 million 

records.  To efficiently search Assets, you will need some key information, such as the Serial Number (the actual 

credential for the license), the VAR, the Product, and possibly even contacts.  Of course, as noted earlier in this guide, 

you can create a custom query to present a list of only those assets for your own areas of expertise and responsibility. 

There are many data points of concern when looking at assets.  Each asset has a unique ID (record identifier).  Assets 

may or may not have a serial number.  A license serial number can refer to many assets.  The order number and part 

number fields can be useful, but not to everyone.  The status field is crucial.  An Active license means the asset is current 

and the customer is always eligible for support. 

The drop down selector has fields you can use for refining your search, as shown here: 
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Enter search values in the adjacent find control to further refine the list of assets. 

You can use the varioius View Tabs to dig deeper into the issue once you have found the asset you are looking for: 
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3.3. Siebel CC View Customization 

As a user of Siebel, you have fine grained control over how data is displayed in your work environment.  Here are UI 

elements that you can control: 

 Selecting Columns Displayed 

 Changing Column Order 

 Adjusting Column Width 

 

3.3.1. Selecting Columns Displayed 

You can configure the columns of data displayed in your Siebel UI.  The Siebel CC uses an Oracle enterprise relational 

database as its repository.  A relational database stores data in tables, a two-dimensional structure.  A table consists of 

columns, or fields, of distinct data, and instances of data referred to as records or rows.  Each record or row has a data 

storage item for every column defined in the table.  A relational database is a collection of tables that can be related to 

each other to capture and represent needed information based on an organizing principle.  The organizing principle for the 

Siebel CC is the Service Request.  When you click on a tab and view its data, you see one or more records or rows of 

data with the named columns shown vertically.   

A tab’s view is a subset of the data.  Not all columns are displayed.  However, you can decide for yourself which columns 

are shown in your view of the tab’s data.  Remember that each tab has its own data configuration.  So you can configure 

and select what columns to view on a per tab basis.  Selecting a column for one tab’s view will NOT affect the column’s 

display in another tab’s view.  Also, it is important to stress the risk involved in this capability.  You may add superfluous 

data to a view that only distracts, or you might exclude data that is crucial from a view.  If you are uncertain, discuss your 

tab display options with your mentor, your peers, and your manager.  You can always undo any display choice, as 

changing a view of the data does NOT change the data itself. 
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To start, first click on the tab you want to configure, such as the Service tab.  Then use the ‘CTRL+SHIFT+K’ shortcut or 

go to the top level Siebel CC Application Menu and select View > Columns Displayed, as shown here: 

 

This activates a pop-up dialog box for you, with the column pick controls highlighted in a red rectangle, as shown here: 

 



78 
 

In the scrollable list on the left are all available columns for the Service Tab page.  In the scrollable list on the right are all 

the currently configured columns for the Service Tab page.  To add a new column to the view, click on its name in the 

Available Columns list on the left.  When the desired column name is highlighted, click the move control (>) to add it to the 

Selected Columns list.  You can highlight several columns for simultaneous moves.  When you click the Save button, your 

Siebel CC’s Service Tab page will now have the data for the added column.  The >> and << controls are for moving ALL 

columns. 

You can also do the reverse by selecting a column from the Selected Columns list so that it is highlighted, then clicking 

the move back control (<) and then clicking the Save button.  The Restore Defaults button will reset the Tab’s column 

display to how it was configured when you first got your Siebel CC account.  If you make a wrong change, click the Cancel 

button. 

As a comparison, here is the pop-up menu for configuring the columns displayed on the Assets tab page: 
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3.3.2. Changing Column Order 

The ordering of a tab view’s columns allows you to gather together related columns important to you.  Column order is 

perceived as left to right.  There are two ways for you to change a tab’s column order.  Remember that these settings are 

per tab, and changing their order of display does not change the data, only your view of it. 

The first method we glimpsed in the previous section.  Select the Service tab.  Select the Application Menu View > 

Columns Displayed (or use the ‘CTRL+SHIFT+K’ shortcut). This activates a pop-up dialog box for you, as shown here 

with the column ordering controls highlighted with a red rectangle: 
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Change the column order in the Selected Columns scrollable list by moving highlighted column names up (to the left) or 

down (to the right).  If you highlight a name and click the up control, it moves the column up above its predecessor (to the 

left of it in the display).  Clicking the down control moves the column name below its successor (to the right of it in the 

display).  Several columns can be highlighted and moved this way.  Clicking the up-most and bottom-most controls for a 

highlighted column moves it to the left-most or right-most position in the tab column display.  Remember to click the Save 

button to capture your ordering configuration permanently. 

The other way to change column order is intuitive and simple.  Click on the tab to get its view displayed.  Left-click on the 

desired column name, keeping the mouse button down.  This will highlight the column name and grab the entire column 

and make it moveable.  While still holding the left mouse button down, drag the column (i.e.: the mouse) to the left or right 

to position it where you want.  Then let go of the left-mouse button.  Siebel will reposition the column and its data to that 

place.  Below is the same two rows of data, with a ‘before’ and ‘after’ column move operation: 

Before Column Move: 

 

After Column Move: 
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3.3.3. Adjusting Column Width 

You may have noticed in your various tab page views that columns have different widths, or that the width of some 

columns is not sufficient to show all the data there.  Remember that the display of the data is independent of the data 

itself.  This principle means that you can alter the display of your data without changing the data.  In practice, this means 

that you can alter the width of any column on any tab page in the Siebel CC. 

For example, consider the Service tab page.  The Summary column width is insufficient to show all of its contents, as 

illustrated below: 

 

To alter this display, use the common mouse interface to expand the column width.  Mouse over the Summary column 

name to its right side or left side edge until you see the mouse icon change to <-||->.  Press and hold the mouse’s left click 

button.  This allows you to move the column edge left or right to expand (or contract) the column width.  When you have 

the column width adjusted to what you need, release the mouse down (unclick the left mouse button).  Siebel rearranges 

the display with the new column width, as illustrated here: 

 

This change will persist when you click on another tab and then return to the Service tab page. 
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3.3.4. Sorting Columns 

Siebel allows you to sort on a column in any tab page’s view.  However, there are two caveats you need to be aware of 

before attempting this.  First, only do a column sort on your own subset of data.  Siebel’s default mode is to show all SRs 

across all all organizations.  This constitutes many millions of records, and a sort of that size will take considerable time.  

Siebel will appear to be ‘hung’ and not responding.  When you are in this mode, Siebel always displays this fact in the 

upper left part of the display area: 

 

Do NOT attempt a column sort when you see this mode.  Change the mode to viewing your service requests: 

 

Column sorts of a relatively small subset of data will be speedy with no noticeable delays.  The second caveat is that 

column sorting is not persistent.  When you change views and then return, the column sort will not be there.  You can 

create custom queries that will sort SRs, and this query’s definition is persistent.  But again, when you change views, the 

sort order is lost until you re-run your defined query. 

That said, you may find that you need to do a sort on a working set of SRs.  Perhaps you have have dozens of assigned 

SRs.  You need to know at a glance which SRs you have started working on and which you have not handled yet.  Sorting 

on the Status column will help you.  When you left click on the column’s name, the column controls appear: 

 

The up control means Sort Ascending, and the down control means Sort Descending.  Ascending or descending refers to 

Sort Order, which is an alphanumeric criteria.  Ascending means sorting from a lower value to a higher value, and 

descening means sorting from higher value to a lower value. 
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If you click the down arrow, the column is sorted in descending order: 

 

If you click the up arrow, the column is sorted in ascending order: 

 

Note that when the sort is completed, the control icon is added to the column name as an indicator that a sort operation 

has been done.  Once more, changing the view of the data does not change the data itself.  When you click on another 

tab and return, the sorting will not persist. 

 

3.3.5. Locking Columns 

The Siebel CC has additional UI features to help make your work easier.  One of these features is column locking.  Most 

columns in most tab view pages can be locked by choice.  This UI lock does not alter the data or affect its writeable state 

in the underlying Oracle database.  The UI lock fixes the column’s position in the UI display to affect horizontal scrolling.  

To enable this feature, you might need to move the columns you want to lock to the left most position in the display.  This 

is not required, but it makes the display more understandable.  When locked, the horizontal scroll bar will leave the locked 
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columns and their data in place and allow you to use the horizontal scrollbar to easily slide horizontally through the 

unlocked columns. 

To lock a column, left-click on the column name.  This brings up the column controls group as previously discussed: 

 

Note the lock icon on the right side of the column controls group.  Mouse-over the lock icon and left-click on it.  The 

column will then have the lock icon adjacent to the column name in the display.  Repeat this step for all columns you need 

to lock.  This indicates locked columns, as shown here: 

 

Horizontal scrolling will now slide through the unlocked columns to the right, as shown below: 

 

To unlock a column, first reverse the horizontal scrolling by scrolling all the way to the left.  Then mouse over the locked 

column’s name and left click.  You will see the column controls again, but now the unlock icon is on the right side: 
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Left-click the unlock icon to remove the column lock.  The column name now no longer has the lock icon.  This is a very 

easy to use feature than can be a real facilitator when you need to browse a lot of record data.  Also note that the column 

lock persists through tab view changes. 

 

3.4. User Preferences 

The Siebel CC is highly customizable for users.  You can tailor your work environment to help you to focus and operate 

with more efficiency.  Here are some of the customizations that are available to you as a TSE: 

 Editing the tab layout to setup hidden tabs and to show them as needed 

 Changing tab order 

 Changing your password  

 Setting up and using default queries 

 

3.4.1. Hidden Tabs 

In its default mode, the Siebel CC has a large variety of tabs visible when you first log in.  Section 3.2.1 of this guide 

provided a summary of these tabs.  In actual practice as a TSE, you will not have a use for some of these tabs.  As such, 

they become visual noise.  Fortunately, the Siebel UI provides the means for you to suppress the display of these tabs. 

To hide a tab, first go to the top level Application Menu and select Tools > User Preferences, as shown below: 
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You will land on your User Preferences page.  Click on the Tab Layout tab to navigate to the Screen Tab Layout page, as 

shown here: 
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This view lists all Siebel tab pages, in groups of 10.  The up and down controls allow you to page through the list.  Each 

tab has a checkbox field in the Hide column.  To hide a Screen Tab, simply check the Hide box.  As a TSE you will 

probably never use the Enhancement Request Survey and the Calendar tabs.  Click the Hide checkbox for both tabs so 

that both fields shcw the checkmark.   

This is a persistent setting.  However, to see the change you must first log out of Siebel and login again.  The 

Enhancement Request Survey and Calendar tabs are no longer visible. 

Return to the User Preferences > Tab Layout page.  Click on the Service item in the list.  You will see the View Tab 

Layout list in the secondary list below: 

 

You can hide any of the associated View Tabs for any Screen Tab by clicking on the checkbox field in its Hide column.  

This functionality works the same as hiding Screen Tabs.  Remember you are only suppressing the tab’s display, not 

removing it from Siebel.  You can reverse the process and uncheck a hidden tab and restore it to your display. 
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3.4.2. Changing Tab Order 

You can change the ordering of tabs in your Siebel working environment.  Tab order is perceived as left to right, with the 

left-most tab ranked with the lowest number (or highest place) on the list.  Each tab is assigned a positional number in this 

scheme.  To change a tab’s order in your working environment, you need to change the tab’s assigned numeric ranking. 

To change the tab order, first go to the top level Application Menu and select Tools > User Preferences.  You will land on 

your User Preferences page.  Click on the Tab Layout tab to navigate to the Screen Tab Layout page, as shown here: 

 

This list has over 40 tabs, shown in groups of 10 by numeric order.  Note that number 6 on the list is Calendar.  In the 

previous section we hid the tab.  However, it is still ranked in Siebel, even if it is not displayed.  Click on the 6, change it to 
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45 and press the Go control (->).  This rebuilds the list.  If you click the move to last, you will see the Calendar tab’s 

setting there: 

 

Siebel put it at the end of the list and changed its rank to 40.  Go to the start of the list to see the revised tab order: 

 

If you click on Home or the Service tab, you will see this numeric ranking in the displayed tab ordering.  You can change 

any tab’s numeric ranking and thus move its position in the tab display.  You can use the find tool to find any tab by its 

name or numeric rank (Order): 
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3.4.3. Changing Your Password 

Your Siebel login name and password were assigned to you.  However, you can change your password as needed.  Click 

on the top level Application Menu Tools > User Preferences.  You will land on your User Profile page.  Click on the 

Change Password button: 

 

This will initiate a guided sequence.  First you must login to Siebel again using your current credentials: 
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Next, you will be prompted to first enter your current password and then enter your new password twice.  You must follow 

the guidelines in the dialog box: 

 

Your old password must be correct.  Your new password must match both times you enter it, and it must not be the same 

as your current password.  When you get a success message, you must login to Siebel with your new password. 

 

3.4.4. Changing Your Time Zone 

When you view your SRs and Activities using your Siebel login, you will notice that your actions have a date-time stamp.  

Siebel associates a value for these date-time stamps using your time zone.  Usually, this is the time-zone where you live 

and work.  What happens if you need to travel for work and you are in a different time zone?  This is a common 
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experience for a TSE.  Or you might need to change your time zone for some other reason or purpose.  You can change 

your time zone by accessing your User Preferences in the Siebel CC. 

Navigate from the main Application menu to Tools > User Preferences.  You will land on your Siebel User Profile page.  

Your Time Zone setting is on the bottom left side of the record editor, as shown here: 

 

 

To change your Time Zone, click on the control at the right end of the record.  This will bring up a Time Zone Picker to 

allow you to set your time zone, as shown below: 
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Note that the time zones are world-wide.  Use the controls to navigate to your desired time zone and then click on it to 

highlight the time zone.  Click the ‘OK’ button to change the setting.  The Picker will then be removed.  Enter ‘CTRL+S’ at 

the keyboard to save the change.  Your setting has been changed.  However, this setting is operationally enforced only 

when you login to Siebel.  To see this change, you need to logout and then login again.  Your new time zone setting will 

then be reflected in the date-time stamps on your actions. 

[TIP:  this setting is per machine only.  If you have Siebel access on several machines, such as a desktop and a laptop 

PC, with access to another office PC, you will need to change your time zone setting on EACH machine you access.] 
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3.4.5. Changing Your Availability for Auto-Assignment 

When you work as a TSE, your workload status is assessed by Siebel algorithmically.  TSEs are grouped into functional 

Areas with specific skills in the Siebel CC.  When SRs are created, they automatically have their status set to Open and 

Unassigned.  They are moved into an internal queue within Siebel.  Every two hours a background process in Siebel 

evaluates these new SRs and assigns them to TSEs.  First, they are ranked by Severity, so Critical or High SRs get 

assigned first, and then older ranked SRs are handled before newer ranked SRs in the queue.  Siebel then goes through 

the ranking and processes them by functional Area, then by Geo (location), and finally by TSE skill in order to match the 

SRs to the most appropriate TSE.  This algorithmic process is referred to as Auto-Assignment. 

As a TSE, your input into this process is your availability for being assigned new SRs.  If you have less than 10 Open and 

Updated SRs, Siebel assesses you as available to be assigned additional SRs.  If you have 10 or more Open and 

Updated SRs, Siebel assesses you as unavailable.  However, you can manually change your availability when you need 

to (for example, going on vacation). 

You can easily see your availability status when you first login to Siebel.  If your status is available, your Service tab will 

be the same gray color as other tabs.  If you are unavailable, your Service Tab will be color coded red, as shown here: 

 

You can change your availability status by accessing your User Preferences in the Siebel CC.  Navigate from the main 

Application menu to Tools > User Preferences.  You will land on your Siebel User Profile page.  The field that holds 

your availability setting is the Current Status on the upper right side of the page.  This may be blanked out with the label 

name inside the field in faint type, indicating that the setting has never been assigned a value, as shown here: 
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Click the control at the right end of the field to select your availability status, either Unavailable, or Fully Available, as 

shown here: 

 

When your availability status has been changed, the label name will now be visible adjacent to the field, and the field will 

have the current setting, as shown here: 

 

The color coding on your Service tab will always reflect your availability Current Status. 

 

3.5. Using OneSearch 

OneSearch is a newer feature in Siebel that allows you to do generalized searches of topics or keywords.  It also allows 

you to search other databases in addition to searching for SRs.  To use OneSearch, click on the OnsSearch tab.  You 

may only see a partial list of available Screen Tabs.  On the right end of the First Level View Bar is a clickable control (˅) 

to show a dropdown list of the other available tabs , as shown here: 
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Click on OneSearch in this drop down list and you will navigate to the OneSearch page, as shown here: 
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OneSearch searches several databases, including Knowledge Base (KB) Solutions, the Software Performance Report 

(SPR) database, and SolidWorks websites.  The KB database is a collection of questions and answers to SolidWorks 

practices and usage written by TSEs like you and others to help customers and users of SolidWorks.  The SPR database 

is owned by Software Development and QA to manage and fix problems and defects (‘bugs’) in SolidWorks software 

source code.  Quite often SRs refer to KB solutions or SPRs so this is a valuable way for you to see what others have 

done and learned in tackling similar problems related to the one you are currently investigating. 

OneSearch has a very different search syntax than what you have seen when doing SR searches.  The opening page has 

a link with tips for using OneSearch, which is presented here for your convenience. 

Tips for Searching the Knowledge Base 

Here are some helpful tips to improve your Knowledge Base (KB) search results: 

 Use simple phrases and words. 
 When searching for specific words, the order of the words in the search bar does not matter. KB search will return 

any solution or article that contains all of the keywords listed. 
 The SOLIDWORKS KB search engine uses only "double-quotation marks (" ") and the asterisk (*) for search 

operators. A KB search does not recognize the AND, OR, NOT, or other Boolean operators. 
 To search for an exact phase, enclose the phrase within "double-quotation marks". This is a good way to search for 

error message text. Keep in mind that the longer the phrase - the fewer the results. 
 To search for solutions that contain variations of a specific word or text, place an asterisk either in front of or behind 

the search text. For example, the search term Win* returns information that contains the words Windows, WinNT, 
Window, etc. The search term install* returns information that contains the words install, installing, installation, etc. 

 Use exact spelling. The KB search does check for misspelled words. 
 Use the Refine your Search options to filter your search results. This is called guided navigation because the 

results change dynamically based on your search terms and selected filters. 
 Add or remove filters to change your search results. 

For example, if you wanted to search for SolidWorks installation issues, you might enter install* in the search field.  This 

would return a long list of partial matches.  You could then filter the search by checking  ‘Solutions’ to further refine and 

narrow your search, as shown in this example: 
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You can filter by any combination of Solutions, SPRs and Service Requests.  You can also filter by Product, Area, Status 

and Sub Area.  This is a powerful search facility that is very fine-grained yet open-ended.  It is an alternative tool to help 

you find the information you need. 
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4. Service Request Workflow 

4.1. SR Workflow Overview 

The following workflow should be used to ensure a unified process when handling SRs among different Support centers: 
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4.2. SR Workflow Service Level Agreement 

Please use the following Service Level Agreement (SLA) while processing new and existing SRs: 

Standard support 

 Business Impact 

Critical High Medium Low 

Initial Response 4 business hours 8 business hours 24 business 

hours 

48 business 

hours 

Updates 3 business days 5 business days On request On request 

Relief Work 

continuously 

As soon as 

possible 

Reasonable 

efforts 

Reasonable 

efforts 

 

Enterprise Support (ESS) 

 Business Impact 

Critical High Medium Low 

Initial Response 1 business hour 4 business hours 12 business 

hours 

24 business 

hours 

Updates 1 business day 3 business days 90 business 

days 

On request 

Relief Work 

continuously 

As soon as 

possible 

As soon as 

possible 

Reasonable 

efforts 
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4.3. SR Workflow Statuses Unpacked 

This section examines the general or standard workflow, when a SolidWorks VAR creates an SR through the portal.  The 

focus here is how the Status and Substatus fields are used handle SRs.  The entire workflow is also diagrammed from a 

business process perspective in Appendix W of this guide. 

4.3.1. Open - Assigned 

There are several ways an SR can get created.  The general case is that a SolidWorks customer has a need or problem 

which is communicated to the VAR.  The VAR in turn uses the VAR Resource Center (VRC) portal to connect to the 

Siebel CC to create an SR with all of the pertinent information.  When this SR is created, it usually will have the Status set 

to Open and the Substatus set to Unassigned, as shown here: 

 

Note that here the Source field is set to Portal.  This means the SR was created by a VAR.  The Source field is a key to 

understanding how the SR was created.  Open and Unassigned SRs need to be processed quickly, and they are usually 

handled by auto-assignment.  Technical Support managers may review and assign them to specific TSEs.  Or you may 

see a new SR that should land on your desk and you decide to assign it to yourself. 
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When a new SR is assigned to a TSE, its Substatus is changed to Assigned.  This launches the first part of the SR 

workflow process. 

 

This SR Status occurs immediately after it is assigned to a TSE.  It indicates that no work has been done yet by the TSE.  

The VAR can see this SR Status on the VRC portal.  If a VAR calls referencing an SR which is Open and Assigned, the 

TSE answering the phone can and should claim the SR and help the VAR, as per the Service Level Agreement (SLA), 

noted in Section 4.2.  At this point, the Assigned SolidWorks TSE is the Owner of the SR.  Your metrics are based in part 

on how you initially respond to an assigned SR. 

 

4.3.2. Open – In Process 

When you start working on an SR, the first thing to do is to change the Substatus to In Process.  This means that you are 

actively working on it.  If a VAR calls referencing an SR which is Open-In Process, the TSE taking the call should transfer 

call to the SR owner, since the assigned work is underway  
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The SR’s Substatus field will appear this way in the Siebel record: 

 

An SR with the Status field set to Pending could also have a Substatus field that is In Process.  At this point, the 

Assigned SolidWorks TSE is still the Owner of the SR.  Note that when a VAR re-opens an issue, the SR could be 

automatically put in this state. 

 

4.3.3. Pending – Waiting On Customer 

Often you will tackle an SR that has missing information that you need before you can proceed.  There might be a 

question about the license or the product.  Perhaps the Problem Description is insufficient to grasp what the issue is 

functionally.  You could even have a question about the VAR or end customer.  You go to the Activities Tab page and 

communicate, usually with the VAR, requesting a clarification or additional data. 

In this scenario, you would also upate the Status to Pending and update the Substatus to Waiting on Customer, which 

means that you are waiting on the VAR or Customer to respond with the information you need. 

 

In the Siebel record it will appear like this: 
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When you change the Status and Substatus this way, Siebel populates the Auto Close Date field with a date 7 days in the 

future.  If you do not change the Status and Substatus because you did not get the requested information, on the seventh 

day Siebel will automatically close the SR.  The VAR can reopen it later, if needed.  The populated Auto Close Date field 

appears this way in the Siebel record: 

 

Note that the Visible To field is populated with the name of the VAR as well.  This means the VAR can see this status for 

the SR on the VAR Resource Center (VRC).  At this point, the associated SolidWorks VAR is now the Owner of the SR. 
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4.3.4. Pending – Resolved 

In this scenario, as a TSE you have investigated the issue and come up with a resolution.  Typically, you would use the 

Activities tab page to communicate your solution or the steps needed and you are waiting for the VAR to respond.  An 

example of a Siebel record for this state is shown here: 

 

When you change the Status and Substatus this way, Siebel populates the Auto Close Date field with a date 7 days in the 

future.  If you do not change the Status and Substatus because you did not get the requested feedback, on the seventh 

day Siebel will automatically close the SR.  The VAR can reopen it later, if needed. 

Note that the Visible To field is populated with the name of the VAR as well.  This means the VAR can see this status for 

the SR on the VAR Resource Center (VRC).  At this point, the associated SolidWorks VAR or customer is now the Owner 

of the SR, as indicated below: 
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4.3.5. Update – In Process 

There are several ways that an SR would have this state.  The more typical scenario is that a VAR has responded to the 

TSE via a Web Update, and provided guidance or details to move the resolution of the issue forward.  Another scenario 

would occur when a VAR reopened a closed SR.  In this case, Siebel would automatically put the SR in this state.  In 

either scenario, as a TSE you would act on the update and provide a solution, or deternine if still more information is 

needed. 

 

An example of the Siebel record is shown here: 
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When the SR goes into this state, ownership of the SR would automatically revert back to the assigned TSE. 

 

4.3.6. Closed Resolved 

This is the desired endstate for an SR.  As a TSE you have investigated the issue, taken the steps necessary for a 

resolution, communicated with the VAR or customer, fully documented your work, and have consensus on the solution.  If 

you have put the state back to Pending - Waiting On Customer, Siebel would have populated the Auto Close Date field 

with a date 7 days in the future, as shown here: 
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If there is no further action from you or the VAR or customer, on the seventh day Siebel will automatically close the SR. 

 

 

4.3.7. Activities Tab 

The Activities tab is a channel of communications between you and your VARs and customers, and also a clearinghouse 

in the sense that it is used to collect, maintain and preserve all communication interactions.  The communication can be 

bidirectional.  Not only can you send messages and information, but VARS and customers and can send messages and 

information to you as a TSE. 

Here are some important guidelines to keep in mind when using the Activities tab page: 

 Do not disclose non-essential information or anything personal about yourself 

 Do not disclose anything the company, the VAR or the customer would regard as private and confidential 

 Be professional, respectful and circumspect in all of your communications 

 Do not use slang, jargon, or foreign phrases, and keep acronyms to a minimum and always define them 

 Be as focused, concise and as clear as possible 

 All communication should help further a resolution of the issue in the SR 
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To access the Activities tab, select an SR from your Service list and then click on the Activites Tab.  A typical Activities tab 

page is shown below: 

 

The Activities tab page has two sections, each with its own set of controls.  The first section is the Activities list and search 

pane.  It has a searchable list of activities (communications), with a set of controls to search or launch an activity, as 

shown here: 
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The second section is the Activity pane, with controls to show or create an activity (message), as shown here: 

 

Note the Show Customer and Private check boxes above.  The Show Customer check box should be checked only if 

you wish the end customer to be able to view the communication.  The default is unchecked.  As a TSE, you will usually, 

but not always, communicate with VARs. 

However, if you want to save a note to yourself or another TSE, check the Private check box.  This will prevent the VAR 

from seeing the message on the VAR Resource Center.  The default for this field is also unchecked, meaning the VAR will 

be able to see the message, unless you check the checkbox. 

When initiating a communication, click the new (+) control in the Activities pane.  This will start a new entry at the top of 

the Activities pane list, and it will open a blank text editor in the Activity pane.  Be aware of the visibility controls described 

in the previous paragraphs.  The text editor is just that, a text editor.  It does NOT support rich text features such as 

bolding, underlining, italicizing, etc.  It only supports plain text.  Siebel has no spell checker or grammar checker.  [TIP:  

compose your correspondence in an external application (like MS Word) that supports spell checking, grammar checking, 
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etc.  Save it in an external dated file, and paste your message into the Activity pane text editor when you are ready to 

transmit.] 

Select the Type of message.  The most common type of message is a Web Update.  But there are many types of activity 

messages in the scrollable, drop-down list.  The list is shown here in two segments, because the entire list can not be 

imaged at once: 

  
If you want this message to be seen by the VAR, do not check the Show Customer or Private check boxes.  When you 

are done, press ‘CTRL+S’ to save the message to the SR record.  If you clicked on another tab, the message would also 

automatically be saved to the SR record. 
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When you are on the Activities tab, you are in an editor.  Those fields that are not grayed-out’ are eligible for editing.  

Those fields that are ‘grayed-out’ are not editable.  Whatever changes you make in any editable field will also persist 

when you save the activity. 

The Activities tab page Activities pane contains the complete communication history for the SR.  The list of messages is 

scrollable and you can click on and open any of them.  This can be useful to you as a TSE if you need to investigate what 

steps were taken, by who and when.  You can cross-reference this information with the SR history (Audit Trail) for the 

VAR and even the customer (who owns the license Asset).  Moreover, the private observations of other TSEs will also be 

there.  Thus, the Activities tab will be of vital use to you as you work on and resolve issues. 

 

4.3.8. Attaching Files to an SR 

At times you will need to attach various files to an SR as you document an issue and communicate with the VAR or 

customer about it.  Or you may need to see a file from the VAR or customer to be able to fully understand and resolve the 

issue.  The Siebel CC accommodates this need bidirectionally.  Note that Siebel has an attachment file size limit of 200 

MB.  However, larger files below that limit may time-out before the upload or download finishes.  Also, when you initiate 

an upload, you must not change tabs or activity.  It will terminate the upload, so you need to let it continue until it finishes.  

Keep in mind that VARs and customers use different kinds of equipment.  You may be able to upload a file into Siebel that 

a VAR or customer may not be able to download.  There is a private external file transfer facility available for very large 

file objects, as described later in this section. 

The kinds of file attachments used in support of an SR include: 

 Rx snapshot files 

 Screen snaps and other images, including output from SolidWorks 

 Procedures / steps to reproduce an issue or to fix an issue 

 Documents such as ‘.doc’, ‘.docx’, ‘.PDF’, and ‘.txt’ files, etc. 

 Audio, video and animation files 
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To access the Attachments view tab for an SR, click on an SR to open the Service tab.  Then click on the Attachments 

view tab below, as shown here: 
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In the Attachments tab pane shown above, the blue text is a clickable link to start the download.  In this example, the 

attachment is as an MS Word ‘.docx’ file.  Note the visibility indicators.  This TSE has indicated that Show VAR is 

checked, Show Customer is checked, and Update File is checked.  You have fine grained control over who can see any 

file objects you can attach to an SR. 

When you click on the Attachment Name blue hypertext link, Siebel initiates the file download by presenting the File 

Download dialog box, as shown here: 

 

 

When you click the Download button, Siebel transfers control to a Windows common dialog.  This allows you to Open the 

file with the configured viewer (here MS Word), or Save the file to your configured location (usually your defined 

downloads location).  An example is shown below: 
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Attaching (uploading) a file can be done in a couple of different ways.  If you have several files that you need to attach, 

use a tool like 7zip or WinZip to contain the files to a compressed in a ‘.zip’ or ‘.rar’ file.  This has the added benefit of 

reducing the total attachment size.  You can use the Siebel facility to upload a file by clicking on the on the New File 

button in the Attachments view tab, as shown here: 
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This opens a Windows common dialog box to allow you to browse and pick a file for uploading.  When you click the Open 

button on a selected file, Siebel will upload it: 

 

When accepted, it will become a clickable link at the top of the Attachment Name file attachments list: 

 

Another way to attach a file to an SR is to use the Windows File Explorer to pick a file and use the Windows ‘drag and 

drop’ facility to click on the file and drag it to the Attachments page Attachment Name list and then drop it on the list.  The 

file would appear at the top of the list, just the same as using the Siebel New File button. 

As noted, some file objects are huge.  Aside from the difficulty a VAR or customer may have uploading or downloading 

files, you may attempt to attach a file that Siebel will not accept because it is too large.  Dassault has a DS File Transfer 

facility to handle this scenario.  It allows you to enable a temporary file transfer site that is external to SolidWorks, to 

upload very large file objects to it, and to specify who has access to it.  An email will be sent to those you designate with 

access containing a link to the site, some credentials information, and a time limit.  You can extend the time limit, if 

needed. 

To start, you need to access your SWYM account and click on the Filetransfer icon, as shown here: 
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This will connect you to the DS File Transfer page at https://filetransfer.dsone.3ds.com/Home.aspx 

To use this service, you must have a valid Dassault login account.  You will need the contact information for those you 

wish to have access to the temporary site.  Remember this site is for our customers and users to have external access to 

very large file objects.  The site itself is self-prompting and it has its own help.  Below is an image of the site’s landing 

page: 

https://filetransfer.dsone.3ds.com/Home.aspx
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When you use this service, be sure to go the the Activities page for the SR and add a Web Update with a note about what 

was uploaded and who has access to it. 

 

4.3.9. Associating Solutions with an SR 

Dassault maintains a Knowledge Base (KB) intended as a service to help VARs and customers more effectively utilize 

SolidWorks products.  This KB is a searchable collection of solutions, which are answers to technical questions.  The 

SolidWorks Technical Support team and other Services teams provide these solutions for VARs and customers to find 

answers on their own.  Often, customers find an answer in the KB faster than if they consult their VAR.  If customers 

consult their VAR, the VAR often finds troubleshooting advice in the KB faster than if they consult the TS team. 

This self-help system allows VARs to submit fewer Service Requests (SRs) to the TS team, which reduces the workload 

for each TSE.  The KB also allows customers to return to their work more quickly, which helps to increase customer 
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satisfaction.  As a TSE, part of your duties is to author and edit these KB solutions.  The details about that effort are 

beyond the scope of this guide, but here is a link for you to find out more about KB solutions and authoring: 

http://ag-dscollaboration.dsone.3ds.com/sites/DS-SOLIDWORKS-Support-

Technical_Services/tssandbox/Shared%20Documents/Help/SOLIDWORKS_Help_for_TSEs.aspx#t=SOLIDWORKS_Help

_for_TSEs_1.aspx 

You can associate a KB solution to an existing SR.  This may shed light on the issue at hand or even help to solve the 

problem itself.  If you click on the Service tab and peruse the list of SRs, the Screen tabs at the top contain the Solutions 

tab and the Solution Administration tab, as shown here: 

 

The Solution Administration tab is used for authoring, editing and maintaining solutions.  The Solutions tab is used to 

find and relate an existing KB solution to an SR.  You can also relate an existing SR to a KB solution, using the the 

Solutions View tab on a selected SR, as shown here: 

 

Note that these associations are many-to-many, meaning an SR can be associated with more than one solution, and a 

solution can be associated with more than one SR.  Siebel maintains a scrollable list for these associations, as we will 

see. 

http://ag-dscollaboration.dsone.3ds.com/sites/DS-SOLIDWORKS-Support-Technical_Services/tssandbox/Shared%20Documents/Help/SOLIDWORKS_Help_for_TSEs.aspx%23t=SOLIDWORKS_Help_for_TSEs_1.aspx
http://ag-dscollaboration.dsone.3ds.com/sites/DS-SOLIDWORKS-Support-Technical_Services/tssandbox/Shared%20Documents/Help/SOLIDWORKS_Help_for_TSEs.aspx%23t=SOLIDWORKS_Help_for_TSEs_1.aspx
http://ag-dscollaboration.dsone.3ds.com/sites/DS-SOLIDWORKS-Support-Technical_Services/tssandbox/Shared%20Documents/Help/SOLIDWORKS_Help_for_TSEs.aspx%23t=SOLIDWORKS_Help_for_TSEs_1.aspx
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There are several ways to search for a KB solution:  you can use the Solutions Screen tab page, or use an SR’s 

Solutions View tab page, or even use the OneSearch tab page.   

If you click on the Solutions Screen tab, the complete scrollable list of solutions is presented, as shown here: 

 

This view is an inventory of all solutions in the KB.  Get a Record Count to see the size of this list: 
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To find an appropriate solution for your needs, use the search facilty at the top of the list.  The left control is a database 

field selector as a drop-down list of available search categories.  The adjacent right control is an editor that you can use to 

enter specifc values to match for your selector, as shown here: 
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Selecting the Question field selector and then searching for ‘geometry’ yielded a search that returned two KB solutions: 

 

Selecting one of the solutions will open the KB record for it, landing on the More Info View tab, as shown here: 

 

You can use the Attachments, Related Solutions and Service Requests tabs to further investigate the issue. 

If you start from the Service tab and select an SR from your active list, you will open the editor to the first item on your list.  

Then select and click on an SR you wish to associate with a KB solution.  Click on the Solutions View tab, and you are 

now in a position to enter a KB solution for your SR.  Notice the edit controls associated with the SR’s Solutions View 

tab: 

 

You can use the Add control (+) or the Add New control (++) to associate a KB solution with your SR.  If you click on the 

Add New (++) control, Siebel will use your selected SR’s fields as search parameters and potentially find a match.  In this 

case, one draft solution (not officially published yet) is matched, as shown here: 
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If you Save the record, the KB solution is persistently associated with your SR.  If you want to find some other solution, 

click the Add (+) control.  This will bring up a dialog box that allows you to search and select a KB solution.  The default 

selector is set to Solution ID, but you can use the drop down list to search for some other field selector:   

 

In this example, a narrowed search with ‘Visualize’ as a parameter was used, with a short list of matching solutions found: 
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Click on the Add button to associate the KB solution with your SR: 

 

When you save the record, the KB solution is added to your SR’s record.  Remember, this will be visible to VARs and 

potentially to customers, so the added soluton may help clarify the issue for them. 
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4.3.10. Associating SPRs with an SR 

SolidWorks products are software, built to run on MS Windows computing platforms.  Like all modern software systems, 

SolidWorks has defects.  These defects can affect users in large and small ways.  Some of these defects are at the root of 

the issues reported by VARs and customers in SRs.  Of course there are structural practices in place to catch, fix and 

mitigate SolidWorks defects.  That is one of the reasons why there are regular SolidWorks releases, updates, patches and 

hot fixes.  The Software Performance Report (SPR) is the main tool used to document, describe and manage known 

defects.  These SPRs are kept in a separate database called appropriately the SPR database. 

Unlike SRs and KB solutions, Technical Support does not own or manage the SPR database.  The SPR database is co-

owned and managed by Development and QA.  However, as a TSE you do have access to the SPR database, by means 

of an assigned login account and password.  See your manager to get your login credentials, if you do not already have 

them.  Here is the link to the SolidWorks products SPR database: 

http://spr/functions/main.htm 

The important thing to note is that an SR may involve defects that have been identified in the SPR database.  So in 

addition to searching the KB solutions database, you also need to search the SPR database.  Just like KB solutions, 

SPRs can already be associated with an SR, or you can add an SPR association to your SR record. 

Siebel has an SPR Screen tab, and when you click on it, you get a current scrollable list of all SRs.  Note the SR Count 

column (in the red rectangle below).  This is a tally of the SRs associated with each SPR.   This highlights an important 

fact:  the SR and SPR database connections are maintained and updated daily.  Searching the SPR database as you 

investigate an SR can yield very current information.  However, it is quite large: 

 

http://spr/functions/main.htm
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The main SPR Screen tab page is shown here: 

 

Notice the age of the first batch of SPRs in the list.  These records are permanent, so this list can only grow larger. 

However, the columns in the list are sortable by clicking on the column name and then clicking down (ascending) or up 

(descending).  You may find it necessary to sort the list before attempting to find a specific SPR, because of the size of 

the list.  Here is the beginning of the list after a sort by Date Found (descending); these are the most recent SPRs: 
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If you click on an SPR, it will open the record in the Product Defect page.  Most of the fields will be grayed-out to you.  But 

you can read and search through these records for pertinent information. 

 



128 
 

If there is an SR associated with the SPR, it will be shown in the Service Requests View tab immediatedly below the 

Product Defect record, as shown here: 

 

The SR # is a hyperlink.  If you click on it, it will open on the Service tab.  If you wish to associate another SR with wth 

SPR, click on the Add (+) control.  This will present a pop-up window with a search tool on top and a list of SRs below: 
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You can do a search to find a specific SR by its number, or by another field available in the search selector. 

 

When you have found the appropriate SR, click the Add button in the dialog box and it will be added at the top of the 

associated Service Requests list: 
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The linkage between SRs and SPRs is dynamic.  More than one SR can be associated with an SPR and vice-versa.  

When you do associate an SR with an SPR, a process is set in motion to synchronize the links and counts between the 

two databases.  This occurs on a daily batch (overnight) cycle.  Each SR has a Severity and a Severity Reason.  If the 

Severity of an SR is Critical or High, you must enter a Severity Reason.  The Severity in the SR database translates to 

the Customer Impact field in the SPR database, as shown below for an SR and its associated SPR:   

 
 

SR # 1-20819841092 
 

SPR # 1092501 
 

Even though you are required to enter a Security Reason, this field is not picked up in the associated SPR.  However, 

the SPR database does examine all associated SRs, and it sets the SPR Customer Impact field to correlate with the 

HIGHEST Severity rating field of all the associated SRs.  SPRs with a Customer Impact of Critical are addressed first by 

Development and QA. 

 

4.3.11. SR  / SPR Escalation 

Please refer to the documents posted on the VAR Resource Center (VRC) website for the escalation process.  To access 

the VRC internally, first click on this link: 

http://solidworks-intranet.dsone.3ds.com/sites/swintranet/SiteCollectionDocuments/VRC_entryform.html 

Then click on the VAR Resource Center Access link presented on the landing page.  You will navigate to the VRC 

portal. 

http://solidworks-intranet.dsone.3ds.com/sites/swintranet/SiteCollectionDocuments/VRC_entryform.html
https://www.solidworks.com/vrc/products.html
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SR Escalation 
a. https://www.solidworks.com/vrc/Services/service_requests.html 
b. Or, you can navigate to VRC Portal > Support  > Service Requests (SR) 

 
SPR Escalation 

a. https://www.solidworks.com/vrc/Services/sprs.html 
b. Or, you can navigate to VRC Portal > Support  > Software Performance Report (SPR) 

 

4.3.12. Out of Office Procedure 

Out Of The Office procedure (3 days or more): 

- As a TSE, you need to send a list of your “Critical” and “High” SRs to Sarah Siedlar and your manager to distribute 
among your team members so they can monitor them while you are away. 

- Be sure to have a clear summary of what has been done with the issue and what is the next step of action. 

- Set your Out Of The Office (OOTO) email notification to inform VARs you are out of the office and let them know who 
they can contact while you are gone. 

- Upon returning to the office, communicate with your teammates to get updates on “Critical” and “High” SRs to 

determine if you need to resume the work on those issues. 

 

4.3.13. Non-Disclosure Agreement (NDA) 

The NDA (Non-Disclosure Agreement) is used in those cases where customers require a legal agreement in place before 

providing files to us for troubleshooting, etc.  Please refer to the documents posted on the VAR Resource Center website 

for the NDA policy and agreement.  To access the VRC internally, first click on this link: 

http://solidworks-intranet.dsone.3ds.com/sites/swintranet/SiteCollectionDocuments/VRC_entryform.html 

Then click on the VAR Resource Center Access link presented on the landing page.  You will navigate to the VRC 

portal.  The NDA form can be found on the following area of the corporate intranet: 

https://www.solidworks.com/vrc/Services/service_requests.html
https://www.solidworks.com/vrc/Services/sprs.html
http://solidworks-intranet.dsone.3ds.com/sites/swintranet/SiteCollectionDocuments/VRC_entryform.html
https://www.solidworks.com/vrc/products.html
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NDA (Non-Disclosure Agreement) 
https://www.solidworks.com/vrc/Services/NDAs.html 
Or, you can navigate to VRC Portal > Support  > Non-Disclosure Agreement 

 

Here are some other guidelines and reminders on the use of NDAs: 

 Any one in the Technical Support department can provide this document to a customer or a VAR for distribution to 
the customer, where requested, but only Ian Baxter can sign these on behalf of TS (or Rich Welch in Ian’s 
absence). 

 Copies of all signed NDAs (it needs to be signed by both the customer and SolidWorks) must be provided to Sarah 
Siedlar, who will ensure they are filed and distributed to the relevant parties internally.  

 If a customer insists on using their own NDA, this must be approved by Brendan Redmond, Associate General 
Counsel, before it is signed by anyone at SolidWorks. This process will take longer than if the customer is willing to 
sign our standard NDA, due to legal review and any amendments our Legal team may wish to make to the wording 
or conditions of the customer document. In the interests of expediting resolution to technical issues please use the 
standard SolidWorks NDA where this is acceptable to the customer. 

 

4.4. SR Alternative Workflows 

Often you will get an SR that originated from a VAR.  Many of the fields were already filled in.  These SRs had the Source 

field set to Portal.  Your interaction with Siebel was editing the SR.  This is the standard workflow.  However, a significant 

number of SRs are not created by a VAR.  You need to use an alternative workflow, because you will have to create the 

SR yourself.  You may get a call from a VAR, or an email from a customer, or even a message from a SolidWorks sales 

person that requires direct action on your part.  In these scenarios, you will have to use other methods and techniques to 

process the new SR. 

This section examines these non-standard workflows, when a TSE originates an SR from a direct call or email from a 

customer or a VAR.  In these alternative workflows, the Siebel record Source field will have a value other than Portal.  

Usually there will be missing or incomplete information at the start of the workflow. 

https://www.solidworks.com/vrc/Services/NDAs.html
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4.4.1. Direct Call to a TSE 

In this scenario, as a TSE you will receive a direct call about an unreported issue.  VARs or customers could make such a 

call, though it is more likely that it will come from a VAR.  As a TSE there are two things you need to know up front about 

technical support calls.  First, these calls have the highest priority.  You need to triage and initially handle all such calls 

right away.  Second, there is a phone system in place to receive and process technical support calls, but you need to 

understand that there is no synchronization between this call system and the Siebel CC.  One of your key duties when 

handling such calls is to create an SR and enter the appropriate information in Siebel yourself. 

As noted, we do have an automated phone system in place to receive and route techncial support calls.  These calls will 

be timestamped and queued up.  Via the Agent Extension, the calls will be transferred to the most likely and available 

TSE.  There is a web interface to this phone system.  The details of all this were provided to you during your onboarding 

as a TSE, and they are beyond the scope of this guide.  [TIP:  when you make a call to a VAR or customer, use your 

Agent Extension number, not your regular extension outbound facility, in order to mask your personal extension.]  If you 

have questions or need assistance with this phone system, see your manager. 

When you do receive such a call, your first step will be to get some basic information:  the name of the VAR, the product 

family, the issue and the affected customer.  It is possible the call was routed to you incorrectly.  For example, if the 

caller’s issue concerns a Simulation solution and you mainly support CAD, you would need to explain this to the VAR and 

reroute the call.  If the call concerns a product family you do handle, you need to determine the customer’s license status.  

The VAR should have this information.  Or you could get the Seat ID or Serial Number from the Assets Screen tab.  The 

Assets tab will let you search by Serial #, Seat ID, VAR (the Organization field) or by Customer (the Account field).  Use 

the left-most selector to specify the name of the field and the right edit control to specify the Serial #, Seat ID, VAR or 

Customer, as shown here: 
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You could also open the Assets > More Info View tab on any SR and then use the Organization or Account picker to do a 

fast search: 
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After selecting the VAR or customer, you can then find the asset record for the product involved and then click on it.  This 

will open the asset and give you the current status below on the More Info View tab, as shown here: 
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In this illustration, the license has a Status of ‘Active’.  This field could have several other values, for example: 
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As a TSE, you can unequivocally support an Active license.  You can not support a Canceled license.  For the other 

status values, you need to discuss the situation with the VAR and your manager.  The license may have an Entitlement 

Status of Expired.  Perhaps the customer will renew their license if you can help them to understand a feature about the 

product.  Use your best judgment.  Remember your mission:  to help VARs and customers to more fully and effectively 

utilize SolidWorks products. 

For an Active license, the next step will be to create an SR.  On the Service Screen tab page, click the Service Requests: 

New control (+): 

 

This will clear out all the fields in the record area and open a new record for editing.  Siebel will automatically assign these 

fields:  SR #, Status (Open), Substatus (Assigned), Owner (your Siebel account name), Group (Technical Support), and 
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the Agent Opened field (current date / time stamp).  Some fields may be grayed out, with or without a value.  All fields 

with a red asterisk MUST have a value before the new SR can be saved. 

You need to fill in the basic information you have already collected:  the product, the license serial #, the End Account 

(customer), the Organization (VAR), and the Summary (a brief description of the problem).  [TIP:  Put in the license serial 

# first, as this causes other important fields to auto-populate.]  Use the Problem Description field for details, instructions, 

issue data, etc.  Put keywords in both the Summary and Product Description fields.  Do NOT put keywords in the Keyword 

field.  Use your best judgment for Severity.  If the Severity is Critical or High, you will have to provide a Severity Reason.  

Be sure the VAR and customer contact fields are filled in.  [TIP:  you can use the pickers from the Asset tab page views to 

get this information.]  Fill in other fields you think are necessary or helpful.  For the Source field, you will probably select 

Phone from the drop-down list: 

 

For a new SR, you should check the Notify SR Account Enabled checkbox field.  This will send notices to the VAR when 

an entry is created on the Activities or Attachments tabs.  For a New Activity, select Call Inbound. 
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There is one additional step to take before creating the new SR:  be sure this request is not a duplicate, or that it is not 

handled elsewhere.  You need to do a search for other SRs using the keywords you got in your contact.  This will help to 

identify an SR that is essentially a duplicate.  You also need to search the KB solutions database and the SPR database 

to make sure there is not already a solution for the issue, or that it is not a known defect being addressed.  As an 

additional check, use OneSearch to scan all three databases (SR, KB, and SPR).  If you do find relevant information from 

such a search, notify the VAR with the details via a Web Update on the Activities tab. 

When you are satisfied the request is new and unaddressed, then you need to capture the information in an SR.  Review 

the record to be sure nothing was omitted.  Remember that when you create an SR as a result of a call, Siebel has no 

record of this transaction until you create it.  That also means the VAR can not see it until you create the SR.  You need to 

make sure the VAR has visibility of the new SR and any ensuing Web Updates you create or Attachments you add.  

Follow these steps to ensure correct VAR visibility: 

1. The correct VAR organization is listed under the “More Info” View tab field “Visible To:” 

 

2. The VAR is listed as a contact under the “More Info” View tab field “SR Email Address” 

 

Be sure to save the record by entering ‘CTRL+S’ at the keyboard or clicking the command control Save Record selection.  

When your saving is finished, the SR is persistent and ready for resolution handling.  More importantly, the VAR will be 

able to see it. 

 

4.4.2. Email to a TSE and the Use of ‘F9’ in Siebel 

In this scenario, as a TSE you could be assigned an SR whose Source field was set to ‘Email’, or you might receive an 

email about an unreported issue requiring you to create an SR.  VARs or customers could send such an email.  It is 
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possible that a customer will send in a support question from the Customer Resource Center.  When this occurs, an SR is 

automatically generated and an automated email is sent to the customer.  It is very likely you will be assigned such an 

SR.  Here is an example of what these automatically generated SR emails look like: 

 

Notice the SR number and the specific syntax that is used in this automatically generated email.  This syntax will be key to 

your responding to these types of emails with F9, as described in this section. 
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Some products like DraftSight® do not have a VAR associated with them, so direct customer contact for technical support 

is very likely.  Probably you will have even less information to start with in these situations.  So you will have to do more 

searching to find relevant information for the SR.  The search techniques are essentially the same as in the preceeding 

section on handling a call, except you will need to do more investigating. 

One important point needs to be made up front.  Do NOT use your email account (ending in @3ds.com) to communicate 

directly with a VAR or customer.  Siebel has mechanisms to communicate with VARs, via the Activities tab.  You can use 

‘F9’ functionality to send a Siebel generated email to a customer (explained below in this section).  The same principle 

applies to phone calls:  do NOT use your phone extension to call a VAR or customer, always use your Agent Extension to 

make SR related calls. 

Just like direct calls, direct emails are not captured by Siebel, nor is there a transaction record in Siebel.  This is true of 

communication in both directions (to you and from you).  If you use Siebel, there will be a record of the communication.  

Use the same principles described in the previous section to create the new SR and populate the necessary fields.  Of 

course, for the Source field, use the value Email. 

There are two ways to send an email via Siebel.  You can use the application menu and click on File, and then select 

Send Email (File > Send Email [F9]), as shown here: 
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Alternatively, navigate to the Service > More Info tab for the SR, and simply press the function key ‘F9’.  When you 
initiate an email from Siebel, depending on the context, you may see a preliminary Pick Recipient dialog box: 
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Click on the Service Request Contact selection.  Then click on the ‘OK’ button and go directly to the Send Email dialog, 
as shown here: 

 

Note that you can attach a file to the email, which may be important when communicating with a customer.  Remember 
also that the customer may not be able to handle a large file download. 

It is crucial that you use the correct Siebel email template and use the method described here for sending an F9 email to 
prevent false duplicate SRs from being generated. 

When sending an F9 email, there are some important things to keep in mind: 

1. Use the correct SolidWorks email account to send messages from 
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In this dialog, you are given some options about which address your email should be sent from: 

 

 

In most cases, you should select TechnicalSupport as the origin of the email.  This uses the support@solidworks.com 
email address. 

The other option you might use is Beta, which is reserved for emails sent to users who are participating in the Beta 
program.  The Beta program runs in the Summer.  See your manager for details about the annual Beta program. 

2. Use the correct coded syntax to ensure replies are appended to the SR record as Web Updates, instead of 
generating false duplicate SRs! 

All F9 emails require a specific coded syntax in the body of the email so that any email replies from the user will appear 
automatically as appended Web Updates in the Siebel Activities tab.  There are two basic ways to accomplish this.  The 
first method is to manually use the coded syntax yourself. 

Here is an example of the correct coded syntax (the [  ] characters are required): 

[SR:1-1234567890] 

mailto:support@solidworks.com
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The number should be the SR number for the case you are working on.  This can appear at any point in the body of 
the email. A good practice is to put it in both the subject header and in the body at the top of the email message so you do 
not forgot to insert it. 

The second method is to use the Siebel template for F9 emails.  In the Send Email dialog, click on the Body control (red 
circle) to see the list of Siebel email templates: 

 

 

 

Select the SW SR Generic Email template.  This will set up your email in the coded syntax, ready for you to add your SR 
number and message, as shown below: 
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Any email that is sent back to support@solidworks.com without this correct coded syntax will be handled as a new SR, 
and it will be a duplicate SR.  This adversely affects Technical Support metrics and it creates more work for us.  Thus, 
using this coded syntax in your F9 emails prevents duplicate SRs from being created.  There are other email addresses 
that will also automatically generate an SR when used and thus need the coded syntax.  They are: 

 support@edrawingsviewer.com 

 support@3dpartstream.net 

 draftight.professional@3ds.com 

 contentcentral2@solidworks.com 

mailto:support@solidworks.com
mailto:support@edrawingsviewer.com
mailto:support@3dpartstream.net
mailto:draftight.professional@3ds.com
mailto:contentcentral2@solidworks.com
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[TIP: Use a word processor or editing tool to create your email message externally, and then copy paste it into the body, 
with the coded syntax described above.  Use the spelling and grammar checkers.  Also remember that Siebel does not 
have rich text formatting for bolding, underlines, italics, etc.] 

This is the coded syntax that Siebel uses to triage incoming emails from inboxes that it monitors.  If a user replies to an 
email that contains this syntax, then the email will be appended as an Appointment Activity in the SR for that number, 
and the Siebel Status of the SR will change to Updated.  If the incoming email has an attachment, the attachment will be 
appended to the Attachments tab. 

This Siebel processing even applies to Closed SRs; your closed SR will be re-opened, regardless of how old it is!  [TIP: 
formulate stock text about "considering the issue to be resolved", and "submitting a new issue if there are further 
questions or concerns" that you can add to the end of a response that turns into a Pending, Resolved state.] 

Additionally, Web Update activities can be sent to users as emails in SRs with the Source set to Email or Web.  This 
behavior is controlled by the Notify SR Account Enabled option: 

 

This option is only enabled by default for SRs that are received from the VRC (originating Source is Portal) or from the 
Customer Portal (originating source is Customer Portal when the Beta period is active).  For all other SRs, this option is 
disabled.  However, you can enable the option at any time.  When enabled, Web Update activities are sent as emails to 
the address in the SR Email Address field, regardless of the Siebel Source.  If you have attachments to send the user, it 
is recommended to use an F9 email (or DS File Transfer for large files).  If you send a Web Update with this option 
enabled and reference an attachment, the user will have no way of accessing that attachment. 

When you are done creating your new SR record, remember to save it by entering ‘CTRL+S’ at the keyboard or selecting 
Save Record from the command control.  The saved email will be appended to the Activities tab for the SR. 

When done properly, these emails (your emails and the replies back) become part of the searchable SR record on the 
Activities tab in Siebel.  They have information about not only the issue, but also about the customer and VAR.  This can 
be helpful to other TSEs and also to VARs. 
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4.4.3. Direct Message to a TSE and Screen Sharing or DS File Transfers 

You may be engaged in a conversation with a coworker or someone in sales representing a customer’s or VAR’s 

concerns.  They may send you a request via the Skype chat window, or in a shared OneNote file, etc.  A colleague may 

even forward a customer request to you with the Source value set to ‘Internal’.  There is a social media SOLIDWORKS 

User Forum, and sometimes we get a support request from that channel, with the Source value set to ‘Social Media’.  If 

you received a voicemail request, you could set the Source to ‘Voice Message’. 

In any of these instances you might need to do a follow-up investigation, necessitating the creation of a new SR.  These 

kinds of connections may not be typical or common, but they are valid.  You need to respond to them with the same 

approach described in the previous two sections.  Some TSEs set the Source field to ‘Chat’ when they create a new SR 

from such a contact. 

You could get an SR with the Source set to ‘Web’.  This Source value is dedicated for special auto-creating of 3D 

Contentcentral and eDrawings.  So if a user submits an issue from 

https://www.solidworks.com/sw/support/fpsupport/index.htm#_ga=2.31505592.722626805.1552388880-2ee40c50-3e94-

11e9-b0d6-dd41affd8b3b, an SR gets created automatically in Siebel with ‘Web’ as the Source value.  This is the default 

Source for auto-generated SRs for eDrawings, for example example SR: 1-20836434927, Owner: SRCREATORUSER, 

Source: Web. 

What about chat or screen sharing sessions with a VAR or customer?  It is unlikely that a customer or VAR would initiate 

a contact with you this way.  However, a VAR or customer may request such a session to help resolve an issue, or you 

may conclude that such a session would be highly effective to get a positive resolution for an SR.  For certain products 

like Simulation or PDM, screen sharing and remote connections are a common practice. 

Here are some factors to consider when choosing a screen sharing remote connection: 

 Be careful not to reveal confidential information during such a session 

 There is no automatic mechanism in the Siebel CC to log or record this kind of transaction 

 You need to diligently create a Web Update on the Activities tab for the SR to log and write a rationale for each of 

these transactions 

https://www.solidworks.com/sw/support/fpsupport/index.htm#_ga=2.31505592.722626805.1552388880-2ee40c50-3e94-11e9-b0d6-dd41affd8b3b
https://www.solidworks.com/sw/support/fpsupport/index.htm#_ga=2.31505592.722626805.1552388880-2ee40c50-3e94-11e9-b0d6-dd41affd8b3b
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Here are some Screen Sharing guidelines for TSEs. 

 For any remote session that involves a customer and a VAR, whether it be pre-scheduled or impromptu from a 

phone call, all three parties need to be present: you, the VAR, and the customer. 

 Some VARs might request that you conduct the remote session with the customer directly.  The VAR should 

always be present for the meeting to give the customer a complete view of the support organization. 

 We work with VARs to help support our customers; cutting the VAR out of this relationship undermines our 

organization and sets the wrong precedent for the customer. 

 Even if the VAR is sitting in the meeting while muted, their presence is valuable.  It is our responsibility to stress 

this to the VAR and ensure they are present for any real-time communication, including phone calls. 

When sharing supplemental technical documentation, here are some important things to keep in mind: 

 Much like sharing a solution from the Knowledge Base, it is the TSE’s responsibility to ensure that the information 

in the shared content is still technically valid. 

 A TSE needs to make sure that the content is appropriate to share with a VAR or customer.  If the content was 

made for Internal and VAR use only, make sure the VAR is aware that it cannot be shared with a customer. 

 If you refer to a large document like a SolidPractice, make sure to highlight which portion of the document contains 

the relevant information. 

The content you would like to share with a VAR or a customer will most likely be small enough to add under the 

Attachments tab of the SR.  To add the attachment, you can drag-and-drop it into a blank area in the Attachments tab, or 

click the small plus button and browse to your file in Windows Explorer: 
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In general, a file that is ~20Mb or smaller should easily upload to the Attachments tab.  The Siebel size limit on a file 

attachment is 200Mb.  If you have problems uploading a file to the SR, you can create a secure workspace using the DS 

File Transfer site (https://filetransfer.dsone.3ds.com/Home.aspx).  Make sure to put the SR number and possibly the 

customer account name in the workspace name to allow for easy identification of the invitation email: 

 

Upload the file and use the VAR’s email address (generally the SR Email Address: field in the More Info tab) to send an 

invitation using the “Add external members” button: 

 

https://filetransfer.dsone.3ds.com/Home.aspx
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Remember that the DS File Transfer facility puts an automatic time limit on the share.  You can easily extend the 

expiration date, if needed.  Be sure to log this action on the Activities tab for the SR. 

 

4.5. Split SRs 

At times you will be assigned an SR and as you unpack and investigate it, you might discover that there are multiple and 

distinct issues involved.  The VAR or customer might be too close to the problem to discern this.  One of the key 

guidelines for Technical Support Service Requests is that each SR should address one specific and unique issue.  As a 

TSE, you never reject an SR because it covers more than one issue.  It is also wrong to address only one or some of the 

issues in an SR.  You must address all issues in the SR. 

The correct way to handle these situations is to decompose the SR into two or more SRs.  These SRs are referred to as 

‘Split SRs’.  You need to understand that you must fully notify the originating Source (probably a VAR or customer) that 

you have decomposed the reported issue into two or more issues.  You must also perform SR, KB and SPR database 

searches for each of the identified issues to make sure that they are have not already been submitted or handled.  Here is 

summary of the necessary steps to handle a split SR: 

1. Enumerate and describe each issue in the decomposed SR 

2. Do a search to make sure each issue is unique (not a duplicate) and unhandled (not in the SR, KB or SPR 

databases) 

3. Create a new SR – do this once for two issues, twice for three issues, etc. 

4. Copy/Paste the Serial Number field from the originating SR into the Serial Number field of the new SR or SRs 

5. Create the narrative in the Summary and Problem Description fields for each new SR 

6. Put the appropriate values in the as yet unfilled fields, especially Severity 

7. Update the original SR appropriately 

8. Make sure the originating Source is properly notified for the changed originating SR and the new split SRs 

9. Save ALL the SRs 
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Have the originating SR open for editing in the Service Screen tab.  After deconstructing the SR into unique issues and 

doing searches on each issue, you are ready to construct the split SR.  The preferred practice is to create a new SR and 

manually Copy/Paste the originating fields into the new SR as needed.  A key field to copy first is the Serial Number field.  

This will make sure the Visible To field is automatically populated by Siebel correctly: 

  

Alternatively, you might use the Siebel Copy Record command.  This is sometimes problematic, but it is described here 

for your reference.  There are two principal ways to copy an SR.  Enter ‘CTRL+B’ at the keyboard, or use the command 

icon or Application menu to select Copy Record [Ctril+B], as shown here: 
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Siebel will copy the SR into a NEW SR with a new number and open the new SR’s record ready for editing.  You will 

notice that the new SR’s Status is the same.  However, the Summary and Problem Description fields are blank, and the 

Severity field is not set in the new SR, as shown here: 

 

 

 

Whether you create a new SR or Copy Record, you need to make sure the other fields are filled in, including the crucial 

fields that have the VAR and customer contact information.  You need to extract the issue narrative from the originating 

SR and revise it for the new sole purpose SR.  Also, set the Severity for the split SR.  If the Severity is Critical or High, 

you will also need to provide a Severity Reason.  Review and edit other fields as needed.   

Make sure the VAR or customer will be notified for the changed and new split SRs.  Copying the Serial Number field will 

properly set the Viisble To field for these notifications.  You may need to submit an F9 email notification in some cases, 

especially if the originating Source field was not a VAR.  Be sure to Save ALL the SRs. 
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4.6. The About Record 

The Siebel CC has a feature that enables you to see basic information about any object in Siebel: the ‘About Record’.  

You can access this feature by clicking on the gear command icon and selecting it from the drop down list, as shown here: 

 

You can also access the About Record by entering ‘CTRL+ALT+K’ at the keyboard, or selecting it from the main 

Application menu Help > About Record. [CTRL+ALT+K].  Either way, Siebel will present basic information about the 

item in current focus, such as Screen Tabs, View Tabs, Attachments, and Activities listings. 

Below is an example About Record display for an SR: 
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The basic display always is the same.  Only the specific data for the object in focus will vary.  The About Record gives you 

information on when the object was created or updated and who the individual was.  This can be useful in auditing and 

investigating the history of an SR, or tracing the activities of a VAR or customer. 

Consider a scenario where an SR has many attachments – some attachments were added by the TSE and some were 

added by various SR Contacts at the VAR organization.  If the original TSE goes on vacation and the SR gets reassigned, 

the assigned TSE might want to go through the list of attachments to determine who added what.  In Siebel, there is 

unfortunately no ‘Created By’ column in the Attachments tab.  However, using About Record on each attachment will 

show you who last updated the attachment and when. 

There are many uses cases for the About Record.  For example, the Audit Trail tab does not capture every single action in 
an SR.  If you notice an unexpected change in an SR and the Audit Trail shows no record of it, you can check the About 
Record > Updated By to look for clues. 
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Also, you can check About Record > Created By to see who added a certain SPR to Siebel.  Note that for an SPR, this 
would typically be the same person who wrote the SPR in the SPR Database system, but in some cases it can be 
someone else.  For example, SPR 1112855 was initially written in the SPR database by Julien Boissat in December 2018, 
but not added to Siebel right away because Julien discovered it himself while investigating an unrelated customer 
concern.  A customer subsequently encountered the same behavior in March 2019, at which time another TSE, Jay 
Seaglar, added the SPR to Siebel, as shown below: 
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4.7. How To Read An Audit Trail 

Siebel does provide the means to examine the history of an SR, with some limitations.  You can find this information on 

the Audit Trail View tab for an SR you have opened in Siebel.  Click on the Audit Trail tab to bring up the page: 

 

The Audit Trail Items page shows you who did what and when.  The Employee Login field shows who made the change.  

The Operation field shows what was done.  The Field field shows the name of the modified field.  The Old Value and 

New Value fields show the previous and current values for the field.  The Date field gives the Siebel date-time stamp for 

the activity, as shown here: 

 

The default ordering of this view is sorted by Date in descending order (newest to oldest).  This page presents some but 

not all changes for the SR.  It does show actual Siebel record edits, so at a high level you can investigate the history of 

the SR and the chain of actions and decisions that led to its current state.  However, there are some glaring omissions.  

The Audit Trail does NOT document Activities or Attachments histories.  You can examine those artifacts directly and 

check their About Record information. 



158 
 

The following example shows that the TSE made several changes to an SR in a very short period of time: 

 

 

Although you can check the ownership, status, substatus, and severity history of an SR using the Audit Trail, you cannot 

see the history of changes to the contact fields.  If you need to analyze the history of the Activities for an SR, you can 

Export that data to a CSV file and then open the data in Excel to sort and search through it. 

There is one other crucial detail about the Employee Login field.  You may see a login name of SADMIN for some 

transactions.  This name indicates a change made by the Siebel CC itself, for example when an auto-assigned update 

was made. 

While Audit Trail is not comprehensive, it is a good place to start when you need to investigate the history of an SR.   
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4.8. VAR Surveys 

The SolidWorks TSEs are a Level 2 support group.  This means they are not the first level of customer support service 

providers.  VARs are the Level 1 service providers for SolidWorks.  SolidWorks customers contact their VAR for all 

support issues.  Each VAR is expected to field customer requests, investigate issues, search the available SolidWorks 

resources on the VRC, and handle all problems.  If the VAR needs assistance during this process, they create an SR on 

the VRC, which initiates the TSE response and handling of the SR. 

Some VARS have deep expertise and knowledge of SolidWorks products, with a strong organization to support 

customers.  Other VARs are novices, new to SolidWorks, and they may have limited staff resources.  There is always the 

problem of consulting vs. servicing.  TSEs assist and help VARs to meet the needs of our customers.  TSEs do not do 

consulting work for VARs. 

There is an ongoing need to evaluate the VARs, their level of training, their expertise, and their customer support skils.  

This helps us to be more effective in managing our resources and time and to continuously improve the level of support 

our customers receive.  The VAR Survey is designed to address this need. 

The VAR Survey is a small set of standard questions for TSEs to use in evaluating a VAR’s performance.  These 

questions are implemented on the Siebel VAR Survey View tab.  When the SR is closed, the TSE can click on the VAR 

Survey View tab to bring up the page and access the questionnaire. 

Most of the questions have control selectors at the right end of the field for capturing information.  Only the Comments 

edit control allows free form text.  Siebel will capture your responses and use them to aggregate with other TSEs 

reponses to build a profile of the VAR’s quality of support.  Of course the questions are subjective, but when collected 

over time, your responses can help build a composite of the reseller’s performance.  This is useful to determine if the 

reseller needs more training, or if there is a noticeable problem in the pattern of support. 

An example of the VAR survey questions (with responses excised) is shown below: 
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Siebel fills in the date time stamp automatically.  The first question is crucial.  This should always be ‘Yes’.  This survey 

should always be about a VAR, never a customer.  The rating questions are on a scale of 1 to 10, with 10 representing 

the best or highest rating.  Add any Comments that are concise, pertinent and provide further useful information about 

the experience you had handling the SR with the VAR. 

Note that SR should not have been auto-closed.  This is not desirable.  We want the VAR to be responsive and engaged.  

How often should you complete the VAR Survey?  We have a 10% survey completion as a goal.  A good rule of thumb is 

whenever the VAR’s performance is Very Good or Very Poor you should take the time to complete the survey. 

Below is an example of a survey for a Very Good performance: 
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As a contrast, consider this survey response for an underperforming VAR: 
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Use your best judgment.  Be fair but honest.  The point here is not to punish underperforming VARs but to help them 

improve so that they can contribute to the customer’s positive view of SolidWorks products. 
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4.9. Handling ‘SPAM’ (Invalid) And Duplicate SRs 

Unfortunately, there is a substantial amount of noise in SR handling.  Invalid SRs are very common, and they clog the 

Technical Support workflow, consume precious bandwidth, and lower our metrics.  All TSEs are responsible for 

confronting this problem and helping in its resolution. 

What is an invalid SR?  An invalid SR is not generated by a VAR or customer seeking assistance with a SolidWorks issue.  

An invalid SR can be generated because of replies to misunderstdood automated emails, or even a mistake in SR 

handling.  An invalid SR can often look like an actual SR.  Perhaps the most common type of invalid SR is sometimes 

called a SPAM SR.  These invalid SRs are often generated when someone responds to an automated email without using 

Siebel or proper SR email handling.  These emails will generate a new, invalid SR when they get processed in Siebel.  

They have specifc text in the Summary field of the bogus SR:  “Automatic reply Service Request Assignment – some SR 

#”.  See the example below.  Note the text in the Summary field with the red arrow.  Note also the Status / Substatus. 

Invalid SR: 
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You should NEVER change the Status / Substatus of the SR to Closed / Resolved.  When you handle such an SR, 

change its Status / Substatus to Cancelled / Not An Issue, and then save it.  Closing the SR will affect your metrics and 

TS metrics overall.  Cancelling the SR preserves your metrics and it declutters your workload.  Again, Do Not change the 

Status / Substatus to Closed / Resolved.  Change the Status / Substatus to Cancelled / Not An Issue, as shown 

below: 

 

 

If you want to weed-out these invalid SRs, the best method is to conduct your query and then Export the results to an 

Excel ‘.csv’ file.  In Excel, you can search the Summary field for the text ‘Automatic’ or ‘Automatic reply’.  All those SRs 

that match that search should be Cancelled in Siebel.  Remember that you can not query the Summary field in Siebel. 

Duplicate SRs often result from a mistake in the handling of a split SR.  If you have created a new SR that is a duplicate 

of an existing SR, simply change the Status / Substatus to Cancelled / Not An Issue for the duplicate SR. 
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APPENDIX A. Siebel Reference: Simple Query Operators and Examples 

When you create a query, you use operators or conditions that Siebel uses to search the database for matching records. 

Operator Description Example 

* 

Wildcard operator. 

Placed anywhere in a string, returns records 

containing the string or containing the string plus 

any additional characters at the position at which 

the asterisk appears, including a space. 

*rang* finds arrange, arranged, orange, orangutan, range, 

ranges, ranging, rang, strange, stranger, strangest, strangle, 

wrangle, and so on. 

Notes:  

 You cannot use * to find dates. 

 To find words on more than one line in a field, you should 

use * to separate the words. You cannot query for control 

characters or non-printable characters, such as line feeds 

(LF) or carriage returns (CR). 

? 

Wildcard operator. 

Placed anywhere in a string, returns records 

containing the characters specified in the string, 

such that any character may appear at the location 

of the question mark. 

?rag finds brag, crag, and drag. 

t?pe finds type and tape. 

"" 

Surrounds a string that, unless modified by a 

wildcard (* or ?), must be matched exactly. 

Quotes let you query for groups of words in their 

exact order. 

"Sun Solaris" finds records for which the value in the query field 

is Sun Solaris. 

= 
Placed before a value, returns records containing 

a value equal to the query value. 

=Smith finds all records for which the value in the query field is 

Smith. 

< 
Placed before a value, returns records containing 

a value less than the query value. 

<6/20/01 finds all records in which the value of the query field is 

less than 20 June 2001. When entering a date, use the format that 

is specific to your implementation. 
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> 
Placed before a value, returns records containing 

a value greater than the query value. 

>5/31/01 finds all records in which the value of the query field is 

greater than 31 May 2001. When entering a date, use the format 

that is specific to your implementation. 

<> 

Placed before the value, returns records 

containing a value that is not equal to the query 

value. 

<>6/20/01 finds all records in which the value in the query field is 

not 20 June 2001. 

<>Paris finds all the records in which the value in the query field 

is not Paris. 

<= 
Placed before a value, returns records containing 

a value less than or equal to the query value. 

<=500 finds all the records in which the value in the query field is 

less than or equal to 500. 

>= 
Placed before a value, returns records containing 

a value greater than or equal to the query value. 

>=500 finds all records in which the value in the query field is 

greater than or equal to 500. 

IS NULL, 

is null 

Placed in the query field, returns records for 

which the query field is blank. 

Enter IS NULL in the Due Date query field to find all records for 

which the Due Date field is blank. 

IS NOT 

NULL, 

is not null 

Placed in the query field, returns records for 

which the query field is not blank. 

Enter IS NOT NULL in the Due Date query field to find all 

records for which the Due Date field is not blank. 

LIKE 
Placed before a value, returns records containing 

the value. 

LIKE Smi* finds all records in which the query field starts with 

Smi. 

Note: This operator is not required in simple queries. In the 

example above, entering Smi* (without LIKE) in the query field 

returns the same results. To find matches regardless of case, you 

can use ~ (tilde). See ~ for details. 

NOT LIKE 
Placed before a value, returns all records not 

containing the value. 

NOT LIKE Smi* finds all records in which the value in the 

query field do not start with Smi. 

~ 

Placed before LIKE and a value with a wildcard 

operator, returns all matching records regardless 

of case. 

~LIKE Smi* finds all records in which the value in the query 

field starts with Smi, smi, SMI, and so on. 

Note: Using this operator may affect performance. 

 

http://swsiebel.solidworks.com/callcenter_enu/help/siebfindinginfo.htm#queryoper_tilde
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Compound Query Operators and Examples 

When you create a compound query, you must use parentheses to control the order in which the application looks for matching 

records. 

Operator Description Example 

AND 

and 

Placed between values, returns only records for 

which all conditions are true. 

performance* AND *memory* finds all records in which the query 

field starts with performance and also contains memory. 

*disk* and *crash* finds all records that contain both disk and crash 

in the query field. 

OR 

or 

Placed between values, returns records for 

which at least one condition is true. 

*performance* OR *memory* finds all records that contain either 

performance or memory in the query field. 

performance or memory* finds all records in which the query field 

value is performance or in which the query field starts with memory. 

NOT 

not 

Placed before a value, returns only records not 

containing the value. 

*performance* AND NOT LIKE *memory* finds all records that 

contain performance but not memory in the query field. 

NOT (performance OR memory) finds all records that contain neither 

performance nor memory in the query field. 

() 

Surrounds the values and operators that will be 

processed first, regardless of the default 

processing order. 

(sun* OR moon*) AND NOT *stars* returns records in which the 

query field starts with sun or moon, but does not contain stars. 

(performance* OR memory*) AND LIKE (*problem*) finds all 

records in which the query field starts with performance or memory and 

also contains problem. 
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APPENDIX B. Beta Program and Siebel Beta Tab 

The SOLIDWORKS Beta Program is run annually in the Summer (late June to mid September).  Key VARs and 

customers participate with Development, QA and Technical Support to preview, evaluate and provide valuable feedback 

on upcoming product releases.  Here are some key facts participating TSEs need to know about the Beta Program: 

 A revised SR handling process occurs only for those participating VARs and customers 

 The Siebel Beta Screen Tab is used instead of the Service Screen Tab, with notable differences 

 Any saved queries created for the Beta Tab are unique and do not apply to Service Tab SRs 

To access the Beta Tab, start by clicking on the link from the Home page: 
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The main Beta landing page is mostly the same, with some notable differences.  For example, there is a Beta Points 

column, as shown here: 

 

The participating TSEs award Beta Points according to formulas in a table.  When the program is launched every year, 

this table is upated and distributed to participating TSEs for awarding the Beta Points. 

The Beta SR record also has notable differences.  The SRs are autopopulated based on the product serial numbers given 

to participating customers.  One of the key differences is that the Group field defaults to ‘Beta’.  An example of an SR 

record from 2018 is shown below:  
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There are some new fields shown in this record.  The Severity Verified checkbox is crucial.  The SR can’t be closed if 

that checkbox is unchecked.  This forces the TSE to confirm the Severity field and Severity Reason for the SR. 

 

 

The TSE uses the Beta Points edit control to award Beta Points.   
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Another UI addition is the Focus Area checkbox, just below the Beta Points edit control.  Focus Areas are set up for 

each year and announced when the program is launched for the summer. 

 

The SR handling workflow and status changes are the similar to regular SR handling.  However, whenever there is a 

status change that sets an Auto Close date, the Beta practice is for the TSE to shorten the waiting period for the auto-

closure to the next three (3) days.  This is done to speed up and streamline SR processing during the Beta Program. 

Whenver a comment is added on the Activities tab page, the Show Customer checkbox is automatically checked, since 

the Beta Program specifically includes customers. 
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APPENDIX I. ITAR Data Restrictions 

The International Traffic in Arms Regulations (ITAR) is a United States regulatory regime to restrict and control the export 

of defense and military related technologies to safeguard U.S. national security and further U.S. foreign policy objectives.  

We occasionally need to work with ITAR Data.  This type of user data requires special handling instruction.  Below is a 

link for our Technology Control Plan (TCP) for handling restricted data including ITAR and Export Administration 

Regulations (EAR): 

http://ag-dscollaboration.dsone.3ds.com/sites/DS-Legal-Group/ExportCompliance/Military/default.aspx 
 

It is an illegal export to provide “access” [even “potential access” – i.e., an inappropriate person had the ability to see the 

data although they never did see the data] to any person who is not a U.S. citizen or resident alien [holder of a green 

card]. We have many non-U.S. citizens and non-resident aliens employed at SolidWorks, therefore we must be very 

careful in how we handle ITAR Data to ensure we do not carry out an illegal “export”. 

ITAR Data can ONLY be loaded on a standalone computer with restricted access.  It CANNOT be loaded on a computer 

that is accessible via a network. 

ONLY U.S. citizens and resident aliens [holders of green cards] (“a “Permitted Person”) may use the computer on which 

the ITAR data is loaded and may access the ITAR Data. 

If SolidWorks Technical Support receives ITAR Data, a Permitted Person should review the data to diagnose the bug 

being reported.  The Permitted Person must then write a bug report that describes the problem in a generic manner – i.e., 

a manner that a general commercial user might find.  If a model that illustrates the bug must be provided to the 

development group, the bug should be recreated in a model that does not contain ITAR Data.  The bug report provided to 

Development CANNOT contain any ITAR Data.   

If the Permitted Person cannot write up a bug report and/or recreate the bug in a manner that does not contain any ITAR 

data, then an export license must be obtained before the bug report can be forwarded to Development.  The Permitted 

Person should contact the SolidWorks General Counsel and request that they obtain an appropriate export license. 

http://ag-dscollaboration.dsone.3ds.com/sites/DS-Legal-Group/ExportCompliance/Military/default.aspx


173 
 

This process applies whether the ITAR Data is supplied in order to report a bug or to request an enhancement. 

Once the bug report is written and/or the SPR is closed, the ITAR Data should be deleted from the isolated system. 

Special Caution with Enhancement requests. 

If SolidWorks modifies our product in a way that incorporates ITAR Data, our standard product may become subject to the 

ITAR restrictions and we would be severely restricted in our ability to continue to distribute our product. 

Therefore, if a VAR or customer makes an enhancement request, we must ensure that it is a request that has a general 

commercial purpose and we must document the general commercial purpose.  Do Not accept enhancement requests that 

only make sense in the context of ITAR Data. 
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APPENDIX S.  Siebel Setup for F9 email 

Set Up Custom F9 email through Siebel CC In 12 Steps 

By Alani Salih 

1. Login to your Siebel Account 

2. Click ‘Navigate’ > Site Map   
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3. Click  ‘Communication’   
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4. Click on ‘My Profiles’ under communications  
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5. Under Profiles click ‘New’ or plus sign   
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6. Enter the desired name for your email under ‘Name’ field (e.g DraftSight) , please note this name is just 

for your own reference ; the name will not be shown to the receiver. 
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7. Under ‘Driver’ click the magnifier   
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8. Search for ‘Internet SMTP/POP3 Server’ from the list. Use the search filter text ‘Int*’ to find it > select 

‘Internet SMTP/POP3 Server’ > OK  

 

  

 

9. Under ‘Profile Parameters Overrides’ click ‘New’ or plus sign.  

 

 

 



181 
 

10. Click the dropdown under ‘Name’ and select ‘From Address’  

 

 

 

 

11. Under ‘Value’ enter the email address (e.g DraftSight.Professional@3ds.com)   

 

 

 

You have finished.  Save the Record by entering ‘CTRL+S’ at the keyboard. 
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12. Now if you want to reply to a Service Request using F9, click the drop down under ‘From’ then select the 

email you have just set up   
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APPENDIX T.  TSEs Siebel Q & A 

 

Category Topics discussed Email Subject | TSC link Sender | 
Author 

Account | 
ESS 

How to subscribe to SR 
notifications when not the 
owner nor the contact.  If you 
list yourself as a TSAM for an 
account in Siebel, you can 
register for notifications for all 
SR activity which is what I 
have done for DW Fritz and 
Electroimpact.  I am also 
registered for each of my ESS 
accounts.  It’s quite a nice 
feature although it can be a bit 
overwhelming at times. 

RE: Auto Close - No Response presents challenges in 
managing Critsit Accounts 

Andrea, 
Bill 
Briggs 

Using F9 How to confirm that an email 
message created via F9 has 
been sent 

FW: How ot see if an F9 email has been sent in Siebel  Brad 

Communic
ation | 
Pitfall 

Why does test does not 
appear in Siebel? Angle 
brackets "<>" in  Siebel will 
show up as blank spaces in 
VAR and Customer Portal 

https://dsext001-eu1-215dsi0708-
3dswym.3dexperience.3ds.com/#community:520/post:Ymjxoy
rmTWeXHIlRVXcjNA 

David 
Law 

Automatic 
SR 
creation 

Does sending an email to 
PDMWorks.EnterpriseSupport
@3ds.com automatically 
generate an activities 

FW: SR training update and auto-complete v2 Gordon, 
Nicole 
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UI | More 
Info 

Why does the More info tab 
has vanished? How to fix a 
Siebel account specific issue 
of the 'More Info' tab 
sometimes disappearing 

https://dsext001-eu1-215dsi0708-
3dswym.3dexperience.3ds.com/#community:520/post:150016 

Jay 

SR Values 
| 
Entitlement 

What does the Entitlement 
field means? What about 
when it says "ESS" 

 
Jennifer, 
Jose 

Siebel 
environme
nts 

What are the difference 
between the UAT and Test 
environments 

FW: Difference between UAT and Test environment Mike 
Garells, 
Caroline 

Activities | 
Private 

When and how to use Private 
All checkbox in Activities 
(including warning to not fully 
trust it) 

 
Other 
topics 

Browser  | 
Sessions 

How to have two simultaneous 
Siebel sessions 

Jay Seaglar Other 
topics 

Cancelling 
SR 

Cancelling SRs (why? How?) 
 

Other 
topics 

KPI How is my close time 
calculated 

 
Other 
topics 

Navigation How to navigate by drilling into 
link values (e.g. to access 
SPR Technical Comments 
field or view an Account's 
Assets or SRs without having 
to perform queries in 
respective destination tabs) 

 
Other 
topics 

Siebel 
environme
nts 

Additional Siebel 
environments (at least provide 
links and brief explanation?): 
Test & UAT - refer to 

 
Other 
topics 
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'SW_Application_URLs_All.P
DF' perhaps in appendix 

SR 
Creation 

How to create an SR 
 

Other 
topics  

How to triage your SRs? 
(Mark Johnson's 
presentation?) Modifed date 

 
Other 
topics 

Escalation 
SR 

Should I lower the customer 
impact on SR requesting 
escalation? (Yes, the SR 
requesting escalation should 
be lowered to Low). The 
manager in charge of the 
escalation will increase the 
severity of the original SR 

 
TSE's 
question 

Internal 
users 

Where to find a list of TSE 
phone numbers pared with 
Siebel ID? 

 
TSE's 
question 

Solution Should SR have All the 
customer information 

 
TSE's 
question 

SPR If the severity is a question 
should I file an spr 

 
TSE's 
question 

SPR Should customer hit means 
“per customer” of “per SR” (it 
means per customer, this 
means no attaching more than 
one customer) 

 
TSE's 
question 

SPR What happens when 
a  customer has already filed 
an SR in the past (with an spr 
attached) and now open 
another SR with a higher 

 
TSE's 
question 
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customer impact (answer: 
change the severity of the first 
SR) 

SR 
Transfer 

What is the process to transfer 
an SR to other TSE or 
department? 

 
TSE's 
question 

SR 
Transfer 

How to transfer an SR to 
Customer Center 

 
TSE's 
question 

SR 
Transfer 

What SRs should be 
transferred to Customer 
Center 

 
TSE's 
question 

SR Values 
| Product 

Should I rely at the VAR 
entering the correct Product ? 
(No, when in doubt ask) 

 
TSE's 
question 
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APPENDIX W. SOLIDWORKS® Service Request Workflow 

 


